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QJET cross connections 
Expand the E1 / T1 display by clicking on the relevant icons. 
 

 
 

The QJET card can operate in several modes allowing you greater flexibility in tailoring or grooming 
traffic. The Data type selection are Off, E1, or T1 rates. 
 

Note: An unframed E1 / T1 port requires 5 bits (or 40 kbit/s) of overhead traffic per port for 
synchronization. 

An unframed E1 port with 2048 kbit/s of traffic requires 2088 kbit/s of link capacity. 

An unframed T1 port with 1544 kbit/s of traffic requires 1584 kbit/s of link capacity. 
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For each port that you want to put into service, choose the required mode (either Unframed or 
Framed): 

Unframed mode 
Leave the Framed checkbox unticked. 

Select the required Data type from the drop-down list E1 or T1. 
 

 
 

Local drop and insert connections are not possible between Unframed E1 / T1 ports. 
 

Framed mode 
Tick the Framed checkbox. 

Select the required framed mode from the drop-down list: 
 

 
 

Local drop and insert connections are possible between framed E1 ports on the same interface card or 
E1 ports on different interface cards. 
 

Local drop and insert connections are possible between framed T1 ports on the same interface card or 
T1 ports on different interface cards. 
 

Local drop and insert connections are not possible between framed E1 ports and framed T1 ports. 
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E1 Framed Modes 
 
Framed Mode Description 

E1 – PCM 30 Provides 30 timeslots to transport traffic. Timeslot 16 carries channel 
associated signalling data (CAS). 

E1 – PCM 31 Provides 31 timeslots to transport traffic. Timeslot 16 can be used for common 
channel signalling or to transport traffic. 

E1 – PCM 30C Same as E1 – PCM 30 mode but supports CRC-4. 

E1 – PCM 31C Same as E1 – PCM 31 mode but supports CRC-4. 
 

E1 CRC-4 (cyclic redundancy check) is used to ensure correct frame alignment and also used to 
gather E1 performance statistics e.g. Errored Seconds (ES), Severely Errored Seconds (SES). 
 

The first three bits of timeslot 0 NFAS (bits 0,1 & 2) and all of timeslot 0 FAS are not transported  
across the link, but rather terminated and regenerated at each terminal. 
 

The last five bits of timeslot 0 NFAS (bits 3 – 7) are the National Use Bits (NUBs) which can be cross 
connected locally or over the link. 
 

E1 - PCM 30 mode 

E1 - PCM 30 modes are used when access to the signalling bits (ABCD) is required, for example: 

 Splitting a PCM 30 E1 into two separate PCM 30 E1s 
 Cross connecting signalling from DFXS, DFXO or Q4EM interfaces into an PCM 30 E1 
 Drop and Insert connections between PCM 30 E1s 

 

In PCM 30 / PCM 30C mode, the timeslot table left column is used to map timeslot bits and the 
timeslot table right column is used to map CAS bits (ABCD) for signalling. Timeslot 16 is reserved to 
transport the CAS multi frame. 

One use of this mode is to connect the 4 wire E&M interfaces to third-party multiplexer equipment over 
the E1 interface using CAS in TS16 to transport the E&M signalling. 

To configure this mode correctly, you must have a detailed knowledge of the CAS signalling modes for 
the third-party equipment to ensure the signalling bits are compatible and configured to interoperate.  
 

E1 - PCM 31 mode 

E1 - PCM 31 modes are used to cross connect timeslots bits without the signalling bits (ABCD). 

TS16 can be cross connected between E1 ports (to transport the entire CAS multi frame) or used for 
common channel signalling or to transport traffic. 

The timeslot table left column is used to map timeslot bits but the timeslot table right column for CAS 
bits (ABCD) is not used.  
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T1 Framed Modes 
 
Framed Mode Description 

T1 - SF Provides 24 timeslots to transport traffic using the G.704 12 frame Super 
Frame without signalling. There is no CRC capability with the SF. 

T1 – SF 4 Provides 24 timeslots to transport traffic using the G.704 12 frame Super 
Frame with 4 state signalling (AB bits). There is no CRC capability with the SF.

T1 – ESF Provides 24 timeslots to transport traffic using the G.704 24 frame Extended 
Super Frame with CRC and without signalling. 

T1 – ESF 4 Provides 24 timeslots to transport traffic using the G.704 24 frame Extended 
Super Frame with CRC and 4 state signalling (AB bits). 

T1 – ESF 16 Provides 24 timeslots to transport traffic using the G.704 24 frame Extended 
Super Frame with CRC and 16 state signalling (ABCD bits). 

 

For the 24 framed modes of ESF 4 and ESF 16, the Data Link bit is shown in the timeslot table but is 
currently unavailable for use. 
 

T1 - SF mode 

T1 SF mode provides 24 timeslots to transport traffic using the G.704 12 frame Super Frame without 
demultiplexing the signalling. Complete timeslots can be cross connected including the inherent 
robbed signalling bits. 

The timeslot table left column is used to map timeslot bits but the timeslot table right column for CAS 
bits (ABCD) is not used.  

T1 SF mode is used when access to the signalling bits is not required but are transported between 
T1s, for example: 

 Drop and Insert connections between 12 frame Super Frame T1s or data interfaces 
 

T1 - SF 4 mode 

T1 SF 4 mode provides 24 timeslots to transport traffic using the G.704 12 frame Super Frame with 
four state demultiplexed signalling using the AB bits. 

The mapping left column is used to map timeslot bits and the timeslot table right column is used to 
map the CAS A&B bits for signalling (C&D bits are not used).  

T1 SF mode is used when access to the signalling bits is required, for example: 

 Cross connecting signalling from DFXS, DFXO or Q4EM interfaces into a 12 frame Super 
Framed T1 using ‘multiplexed’ signalling from the interface. 

 Drop and Insert connections between 12 frame Super Framed T1s or data interfaces 
 

T1 - ESF mode 

T1 ESF mode provides 24 timeslots to transport traffic using the G.704 12 frame Extended Super 
Frame without demultiplexing the signalling. Complete timeslots can be cross connected including the 
inherent robbed signalling bits. 

The timeslot table left column is used to map timeslot bits but the timeslot table right column for CAS 
bits (ABCD) is not used.  

T1 ESF mode is used when access to the signalling bits is not required but are transported between 
T1s, for example: 

 Drop and Insert connections between 24 frame Extended Super Framed T1s or data interfaces 
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T1 - ESF 4 mode 

T1 ESF 4 mode provides 24 timeslots to transport traffic using the G.704 24 frame Extended Super 
Frame with four state demultiplexed signalling using the AB bits each with a bit rate of 667 bit/s. 

The mapping left column is used to map timeslot bits and the timeslot table right column is used to 
map the CAS A&B bits for signalling (C&D bits are not used).  

T1 ESF 4 mode is used when access to the signalling bits is required, for example: 

 Cross connecting signalling from DFXS, DFXO or Q4EM interfaces into a 24 frame Extended 
Super Framed T1 using ‘multiplexed’ signalling from the interface. 

 Drop and Insert connections between 24 frame Extended Super Framed T1s or data interfaces 
 

T1 - ESF 16 mode 

T1 ESF 16 mode provides 24 timeslots to transport traffic using the G.704 24 frame Extended Super 
Frame with sixteen state demultiplexed signalling using the ABCD bits each with a bit rate of 333 bit/s. 

The mapping left column is used to map timeslot bits and the timeslot table right column is used to 
map the CAS ABCD bits for signalling.  

T1 ESF 16 mode is used when access to the signalling bits is required, for example: 

 Cross connecting signalling from DFXS, DFXO or Q4EM interfaces into a 24 frame Extended 
Super Framed T1 using ‘non-multiplexed’ signalling from the interface. 

 Drop and Insert connections between 24 frame Extended Super Framed T1s or data interfaces 
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Selecting and mapping bits and timeslots 
This section describes how to select and map: 

 a single bit 
 multiple bits 
 a 64 kbit/s timeslot 
 multiple timeslots 

 

Selecting a single bit 
Each timeslot is represented by 8 rectangles (each representing a single bit). Each bit can carry 8 
kbit/s. 

One or more consecutive bits can be selected in a timeslot if a rate of greater than 8 kbit/s is required.  

1. Click on the rectangle that represents the bit you require. It will turn red. 
 

 
 

2. Click and drag this bit to the rectangle representing the bit on the interface you want it to be 
connected to, and release the mouse button.  

 

 
The red rectangle will be replaced by the allocated connection number at each interface. 
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Selecting multiple bits 
It is possible to select multiple consecutive bits if circuit capacity of greater than 8 kbit/s is required.  

1. Click the first bit, and then hold down the Ctrl key while selecting the remaining bits.  
 

 
 

2. Click and drag the whole block by clicking the bit on the left hand side of your selection, and drag 
to the required interface. Release the mouse button.  

 

Tip: It is also possible to select multiple bits by holding down the Shift key, and dragging across 
the required rectangles. 

Differing numbers of bits display in different colors when the cross-connect is completed: 
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Selecting a 64 kbit/s timeslot 
1. Click on the TSX timeslot number (where X is the desired timeslot from 1 to 31). 
 

 
 

Alternatively, right-click over any of the bits in the timeslot, and click on Select Timeslot. 
 

 
 

2. Drag and drop in the normal way to complete the cross connection. 
 

Selecting multiple non consecutive timeslots 
1. Click on one TSn timeslot number (where n is the desired timeslot 1 to 31). 

2. Hold down the Ctrl key while clicking on each of the required timeslot numbers. 
 

 
 

3. Drag and drop in the normal way to complete the cross connection. 
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Selecting multiple consecutive timeslots 
1. Click on the first TSn timeslot number (where n is the desired timeslot 1 to 31). 

2. Hold down the Shift key while clicking on the last required timeslot number. 
 

 
 

3. Drag and drop in the normal way to complete the cross connection. 
 

Selecting all timeslots in a port 
1. Right-click over any of the rectangles. 
 

 
 

2. Click Select All. 
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Q4EM cross connections 
1. Expand the Q4EM display by clicking the relevant  icon. 
 

 
 

2. Set the Voice capacity by selecting 16, 24, 32, or 64 kbit/s rates. 

3. Drag and drop from the Voice mapping connection box to the required partner interface to create 
the voice cross connection. 

4. If E&M signalling is required, drag and drop from the Signalling mapping connection box to the 
required partner interface to create the E&M cross connection. 
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DFXS & DFXO cross connections 
1. On one side of the link, expand the DFXS display, as required, by clicking . 
 

 
 

2. On the other side of the link, expand the corresponding DFXO display, as required, by clicking . 

 
 

3. For the DFXS card and corresponding DFXO card, select the Signalling type as required, 
according to the table below. The CAS signalling between DFXO / DFXS interfaces uses 4RF 
proprietary allocation of control bits. 

The Signalling type affects both ports of the DFXO / DFXS interface. If a mixture of signalling 
types is required, then multiple DFXO / DFXS cards are needed. 

 
Signalling Application Overhead 

Multiplexed 
(default) 

Multiplexers the four ABCD bits from the interface into a 
single 8 kbit/s channel. 
Use when interworking DFXO to DFXS, between an XE 
and a SE radio or when limited bandwidth is available. 
This signalling type cannot be used for interworking 
between framed E1 and voice interfaces. 

8 kbit/s 

Non-multiplexed Transports each of the four ABCD bits in separate 8 kbit/s 
channels. 
Use when interworking DFXO cards to DFXS cards or 
when signalling bits are mapped into an E1 / T1 timeslot. 

32 kbit/s 

4 wire compatible Use when interworking the DFXO card or DFXS card to a 
Q4EM interface 
• DFXS to DFXO A bit mapped to off-hook 
• DFXO to DFXS A bit mapped to fault 

8 kbit/s 

 

4. Set the Voice capacity and create the Voice connection by dragging and dropping between the 
mapping connection boxes of the DFXO and DFXS corresponding ports. 

5. Link the Port Signalling connection by dragging and dropping between the mapping connection 
boxes of the DFXO and DFXS corresponding ports. The DFXO / DFXS control signals (off hook, 
ring, etc) will not function without this connection. 
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QV24 cross connections 
1. Expand the QV24 displays, as required, by clicking the relevant  icons. 
 

 
 

2. Select the Port Baud Rate as required (default is 9600). 
 

3. Drag and drop to the required partner interface to create the V.24 Data connection. 

If the partner interface is a QJET: 

 If the V.24 Baud Rate selected is 38400 is less, drag from the QV24 mapping connection box 
to the QJET timeslot. The correct QJET capacity for the baud rate selected will automatically 
be assigned. 

 If the V.24 Baud Rate selected is greater than 38400, select the QJET capacity required, as 
per the following table, and drag from the QJET to the QV24 mapping connection box. 

 
Baud Rate Bits Required Bit Rate 

300 - 7200 2 16 kbit/s 

9600 - 14400 3 24 kbit/s 

19200 - 23040 4 32 kbit/s 

28800 5 40 kbit/s 

38400 6 48 kbit/s 

57600 9 72 kbit/s 

115200 16 128 kbit/s 
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HSS cross connections 
1. Expand the HSS displays, as required, by clicking the relevant  icons. 
 

 
 

2. Select the Synchronous Clock Selection mode (see “HSS synchronous clock selection modes” 
on page 114).  

 

 
 

3. Set the Data rate to a value between 8 and 2048 (in multiples of 8 kbit/s). 

The net data rate available to the user is defined by Data Rate – overhead 

e.g. a date rate set to 2048 kbit/s with an overhead of 40 kbit/s provides a user data rate of 2008 
kbit/s 

4. Drag and drop to the required partner interface to create the HSS Data connection. 

If the partner interface is a QJET, select the capacity on the QJET and drag it to the HSS Data 
mapping connection box. 

The QJET capacity selected must be the sum of the data rate required plus the overhead rate 
selected. 

 

5. Drag and drop to the required partner interface to create the HSS Signalling cross connection. A 
minimum of 8 kbit/s of capacity is required and must be set symmetrically at both ends of the link. 

 



Cross Connections  |  147 
 

 

Cross connection example 
This is an example of cross connection mapping: 
 

 
 

Circuit Local port Remote port Capacity 
(kbit/s) 

Connection
numbers 

Radio management   64 1 

User Ethernet   1024 2 

3 wire E&M circuit Q4EM port 1 
(slot C) 

Q4EM port 1 
(slot C) 

72 7/15 

Unframed E1 data QJET port 1 
(slot D) 

QJET port 1 
(slot D) 

2088 65 

Unframed T1 data QJET port 2 
(slot D) 

QJET port 2 
(slot D) 

1584 66 

Loop Interface DFXO port 1 
(slot E) 

DFXS port 1 
(slot E) 

72 8/32 

V.24 data circuit 
9600 

QV24 port 1 
(slot G) 

QV24 port 1 
(slot G) 

24 14 

HSS data circuit 
1024 kbit/s 

HSS port 1 
(slot H) 

HSS port 1 
(slot H) 

1088 31/16 
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Symmetrical Connection Wizard 
The Cross Connections application has a Symmetrical Connection Wizard which simplifies the cross 
connection configuration when the terminals are fitted with symmetrical / matching interface types. 

A symmetrical connection is a connection between the local and the remote terminal where the local 
slot, card type, port and connection details are identical to those of the remote terminal. 

The only exception is DFXO / DFXS connections where DFXO cards are considered to match DFXS 
cards (as they normally interwork). 

Framed E1 / T1 CAS connections, drop-and-insert connections, and connections that do not involve 
entire timeslots, are considered to be asymmetrical. 

 

Starting the wizard 
When starting the wizard with unsaved changes, the following popup dialog should appear 

 

 
 

Click on 'Save' if you wish to save the current configuration to a file. Clicking on 'Continue' will continue 
with the wizard and overwrite any changes made when the wizard finishes. 

The wizard can be cancelled at any time by clicking on the 'Cancel' button or by closing the window. 

Wizard Navigation 
Click on the Next button to progress through the wizard. The current stage is indicated in the 
navigation bar on the left. You can jump directly to a stage by clicking on the stage required. 
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Setting the IP address 
If the local or remote terminal IP addresses have been setup, they will be displayed in the Local and 
Remote fields. If the IP addresses are not displayed, enter the IP addresses of the local and remote 
terminals. 

 
 

Click on 'Get Configuration' to upload the existing cross connections configuration from the local 
terminal. The Radio bandwidth bar will show the available bandwidth and will be updated as bandwidth 
is assigned to cards. 
 

Setting the bandwidth 
If the Cross Connections Application is opened from SuperVisor, the Total Capacity of the radio link 
will be shown in the Bandwidth field. 

If the Cross Connections Application is opened as a stand alone application, the Total Capacity of the 
radio link will be need to be entered in the Bandwidth field. 

 
 

The 'Remove asymmetrical connections' button will be active if there are existing asymmetrical cross 
connections.  If you want to remove existing asymmetrical cross connections, click on this button. The 
Radio bandwidth bar will update accordingly. 
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Card Selection 
If the Cross Connections Application is opened from SuperVisor, existing cards installed in the local 
terminal that match cards installed in the remote terminal will be displayed. Mismatched cards will be 
shown as 'Empty Slot'. 

If the Cross Connections Application is opened as a stand alone application, select the card types that 
will be fitted in the terminal. 
 

 
 

To copy the card type selected in Slot A to all the other slots (B – H), click on the Copy 
Card button. This assumes that the same interface card types are fitted in all the card 
slots.  
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Interface configurations 
Setup the interface configurations as per the wizard instructions. Existing asymmetrical connections 
will be replaced with symmetrical connections if an interface parameter is changed. 

Q4EM QJET 

DFXO / DFXS QV24 

HSS Ethernet 

 
To copy the port configuration selected in Port 1 to all the other ports on the card, click on 
the Copy Port button. 

 

To copy the card configuration to all other cards of the same type fitted in the terminal, 
click on the Copy Card button. This can save time when setting up multiple cards of the 
same type.  
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Symmetrical connection summary 
 

 
Click Finish. 

 

Send symmetrical connection configuration 
Click OK to send the configuration to the terminals. 
 

 
 

The process is completed. 

Note: The wizard may change the connection numbers of existing connections. 
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11. Protected terminals 
Monitored Hot Stand By (MHSB) 
This section describes configuring the protected terminal in MHSB mode. A protected terminal in 
MHSB mode comprises two radios interconnected using the tributary and RF switches as shown 
below: 

 

 

 
 
 

The MHSB switch protects terminals against any single failure in one radio. It also monitors the alarm 
output of each radio and switches between radios if major radio link alarms occur. 

The MHSB switch uses a CPU to monitor the alarm status received from both the connected radios' 
alarm ports. When a relevant major radio link alarm is detected on the active radio (that is, transmitter, 
receiver, power supply or modem), the CPU switches a bank of relays that switches all the interfaces 
and the transmit port from the main radio to a functioning stand-by radio. The stand-by radio now 
becomes the active radio. 

The tributary switch and the RF switch are both a 19-inch rack-mount 1U high chassis. The total rack 
space required is 6U. The MHSB switch option is available for the following bands: 300, 400, 700, 900, 
1400, 2000, and 2500 MHz. 
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Tributary switch front panel 
 

 
 
 

No. Description Explanation 

1 Power supply input Input for DC power or AC power 

2 Protective earth M5 terminal intended for connection to an external protective 
conductor for protection against electric shock in case of a fault 

3 Interface ports Port for connecting to customer interface equipment 

4 Radio A interfaces These connect to the interface ports on radio A 

5 Radio B interfaces These connect to the interface ports on radio B 

6 Console For factory use only 

7 Ethernet Port for connecting to customer Ethernet network. This port is also 
used to set up and manage the radios remotely over an IP 
network 

8 Radio A Ethernet Connects to an Ethernet port on radio A 

9 Radio B Ethernet Connects to an Ethernet port on radio B 

10 Alarms Alarm input/output connections for customer equipment 

11 Radio A alarms Connects to the alarm port on radio A 

12 Radio B alarms Connects to the alarm port on radio B 

13 RF SW Provides power and signalling to the RF switch 

14 Mode switch Three-position locking toggle switch to set the MHSB switch into 
automatic mode or radio A / radio B test mode 

15 LEDs Mode and status LEDs 
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Tributary protection switch LEDs 
 

LED Colour Appearance Explanation 

A Green Solid The radio is active and is OK 

 Green Flashing The radio is in standby mode and is OK 

 Red Solid The radio is active and there is a fault 

 No colour (off) - The tributary switch is in 'slave' mode and the 
switching is controlled by the master tributary 
switch 

 Red Flashing The radio is in standby mode, and there is a fault 

B Green Solid The radio is active and is OK 

 Green Flashing The radio is in standby mode and is OK 

 Red Solid The radio is active and there is a fault 

 No colour (off) - The tributary switch is in 'slave' mode and the 
switching is controlled by the master tributary 
switch 

 Red Flashing The radio is in standby mode, and there is a fault 

~ Green Solid The tributary protection switch is in 'auto' mode 

 Green Flashing The tributary protection switch is in 'slave' mode 

 Red Solid The tributary protection switch is in 'manual' mode 
(A or B) 

On Blue Solid Indicates that there is power to the tributary 
protection switch 

 

RF switch front panel 
 

 
 

No. Description Explanation 

1 Radio QMA QMA connectors for connecting the protected radios 

2 Protective earth M5 terminal intended for connection to an external protective 
conductor for protection against electric shock in case of a fault 

3 Antenna port N-type female connector for connection to the antenna feeder 
cable. This view shows an internally mounted duplexer. If an 
external duplexer is fitted, the antenna port will be on the external 
duplexer 

4 Slave tributary switch 
outputs 

Connects to secondary tributary switch for control of additional 
interfaces 

5 Tributary switch Connects the RF switch to the tributary switch (the master if more 
than one tributary switch is required) 

6 LEDs Status LEDs 
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RF protection switch LEDs  
 

LED Colour Appearance Explanation 

Tx A Green Solid RF is being received from radio A 

Tx B Green Solid RF is being received from radio B 

On Blue Solid Indicates that there is power to the RF protection switch 
 

Slave tributary switches 
Each tributary switch protects up to eight ports. Up to three slave tributary switches may be added to a 
MHSB terminal to protect up to 32 ports. Each slave tributary switch is interconnected by means of the 
slave tributary switch ports on the RF switch, as shown below. 
 

Note: A tributary switch that is operating as a slave (rather than a master) has a RJ-45 V.24 loopback 
connector plugged into the console port. If the connector is missing, contact Customer Support. 
Alternatively, you can make this connector. Follow the standard pinouts for a V.24 RJ-45 connection 
(see "QV24 Interface connections" on page 228). 
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MHSB cabling 
The two radios are interconnected as follows: 
 

Caution: Do not connect Transmit to Receive or Receive to Transmit as this may damage the radio or 
the MHSB switch. 

 

 
 

Cables supplied with MHSB 
 

The following cables are supplied with a MHSB terminal: 

 Ethernet interface: RJ-45 ports standard TIA-568A patch cables . 
 Alarm interface: RJ-45 ports standard TIA-568A patch cables. 
 RF ports: two QMA male patch cables are supplied. 

 

MHSB power supply 
 

See “DC power supply” on page 32 and “AC power supply” on page 35. 
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Configuring the radios for protected mode 
The MHSB switch does not require any special software. However, the radios connected to the MHSB 
switch must be configured to work with the MHSB switch. This sets the alarm outputs and inputs to 
function in MHSB mode. 

You must configure the interfaces of both radios connected to the MHSB switch identically. To perform 
this, you can either connect directly to the radio or use the test mode of the MHSB switch. 
 

IP address setup 
Before configuring the link, you must ensure that the two independent links have correctly configured 
IP address details. 

All four radios in the protected link must be on the same subnet. 

 

 

 
 



Protected terminals  |  159 
 

 

Mounting the MHSB radios and switch 
Once the IP addresses are correctly configured, it is important to connect the A and B radios' Ethernet 
and Alarm ports correctly. In general, mount radio A above the MHSB switch and radio B below the 
MHSB switch: 

 
 

There is an Ethernet connection between any of the four Ethernet ports on each radio and the 
Ethernet port on the Tributary switch. There is also a connection between radio A and radio B, which 
ensures Ethernet traffic is maintained if a radio loses power. 

The Ethernet port on the protection switch can be connected to an Ethernet hub or switch to allow 
multiple connections. 

Important: The management Ethernet capacity on each of the four radios in the protected terminal 
must be identical for remote communications to work and there should only be one IP connection to 
the management network (via the tributary switch Ethernet port). 

 

 
 



Protected terminals  |  160 
 

 

Configuring the terminals for MHSB 
It is recommended that you configure the local and remote A side first, then the local and remote B 
side. Both the local A and B radios must be configured identically, and both the remote A and B radios 
must be configured identically. 

Tip: As illustrated below, you may find it helpful to have two browser sessions running simultaneously. 
You can then easily see both the A and B sides of the protected link. 

To configure MHSB operation: 

1. Select Link > Maintenance > MHSB. 
 

 
 

2. Enable MHSB mode. 

3. Select whether the radio is A or B. 

Ensure that the radio connected to the A side of the protection switch (normally above the MHSB 
switch) is set to Radio A and the radio connected to the B side of the protection switch (normally 
below the MHSB switch) is set to Radio B. 

In the event of a power outage, the radios will switch over to the A side of the protection switch 
when the power is restored. The A side is also the default active side. 

 

4. When you have made your changes, click Apply to apply changes or Reset to restore the previous 
configuration. 

5. Repeat steps 2 to 4 for the other side of the protected link. 
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Clearing MHSB alarms 
If a switchover event occurs, the OK LED on the front panel and on the Terminal status and menu bar 
in SuperVisor changes to orange. 

1. Select Clear Switched Alarm from the MHSB Command drop-down list. 
 

 
 

2. Click Apply to apply changes or Reset to reset the page. 
 

Note: When MHSB mode is enabled, external alarm input 2 is used by the protection system to carry 
alarms from the protection switch to the radio. In MHSB mode, therefore, only external alarm input 1 is 
available for user alarms. 
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12. In-service commissioning 
Before you start 
When you have finished installing the hardware, RF and the traffic interface cabling, the system is 
ready to be commissioned. Commissioning the terminal is a simple process and consists of: 

1. Powering up the terminals 

2. Configuring both the local and remote terminals using SuperVisor 

3. Aligning the antennas 

4. Synchronizing the terminals 

5. Testing the link is operating correctly. As a minimum, conduct the suggested tests to ensure 
correct operation. More extensive testing may be required to satisfy the end client or regulatory 
body requirements. 

6. Connecting up the client or user interfaces 
 

What you will need 
 Appropriately qualified commissioning staff at both ends of the link. 
 Safety equipment appropriate for the antenna location at both ends of the link. 
 Communication equipment, that is, mobile phones or two-way radios. 
 SuperVisor software running on an appropriate laptop, computer, or workstation at one end of the 

link. 
 Tools to facilitate loosening and re-tightening the antenna pan and tilt adjusters. 
 Predicted receiver input levels and fade margin figures from the radio link budget (You can use 

Surveyor (see "Path planning" on page 19) to calculate the RSSI, fade margin, and availability). 
 



In-service commissioning  |  164 
 

 

Applying power to the terminals 
 

Caution: 

Before applying power to a terminal, ensure you have connected the safety earth and antenna cable. 

 

Apply power to the terminals at each end of the link.  

When power is first applied, all the front panel LEDs will illuminate red for several seconds as the 
system initializes. 

After the system is initialized, the OK LED on the front panel should illuminate green and if the 
terminals are correctly configured, the TX and RX LED should also be illuminated green. 

 

If the RX LED is: 

 Red — the antennas are may be significantly mis-aligned with no signal being received. 
 Orange — the antennas may be roughly aligned with some signal being received. 
 Green — the antennas are well-aligned and adequate signal is being received to create a 

reliable path. 

 

If the TX LED is: 

 Red — there is a fault in the antenna or feeder cable, or the transmitter is faulty. 
 Green — this means the transmitter is working normally. 

 

Review the link configurations using SuperVisor 
1. Connect a PC, with SuperVisor installed, to both terminals in the link. 

2. Log into the link. 

3. Select Link > Summary and confirm the following basic information: 
 Terminal IP address(es) 
 Terminal TX and RX frequencies 
 RSSI (dBm) 
 TX power (dBm) 
 SNR (dBm) 

 

Note: If the terminals have not already been configured, refer to "Configuring the terminal" on page 
61, "Configuring the traffic interfaces" on page 77, and "Configuring the traffic cross connections" on 
page 121. 
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Antenna alignment 
For any point-to-point link, it is important to correctly align the antennas to maximize the signal 
strength at both ends of the link. Each antenna must be pointing directly at the corresponding antenna 
at the remote site, and they must both be on the same polarization. The antennas are aligned visually, 
and then small adjustments are made while the link is operating to maximize the received signal. 

Directional antennas have a radiation pattern that is most sensitive in front of the antenna, in line with 
the main lobe of the radiation pattern. There are several other lobes (side lobes) that are not as 
sensitive as the main lobe in front of the antenna. 

 

 
 

For the link to operate reliably, it is important that the main lobes of both antennas are aligned. If any 
of the side lobes are aligned to the opposite antenna, the received signal strength of both terminals will 
be lower, which could result in fading. If in doubt, check the radiation patterns of the antennas you are 
using. 

 

Checking the antenna polarization 
Check that the polarization of the antennas at each end of the link is the same. 

Antenna polarization of grid antennas are normally indicated by an arrow or with “H” and “V” markers 
(indicating horizontal and vertical). 

On Yagi antennas, ensure the orientation of the elements are the same at each end of the link.  

Transmit frequency and power, and antenna polarization would normally be defined by a regulatory 
body, and typically licensed to a particular user. Refer to your license details when setting the antenna 
polarization. 
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Visually aligning antennas 
1. Stand behind the antenna, and move it from side to side until it is pointing directly at the antenna 

at the remote site. The remote antenna may be made more visible by using a mirror, strobe light, 
or flag. 

 

If the remote end of the link is not visible (due to smoke, haze, or local clutter, etc), align the 
antenna by using a magnetic compass. Calculate the bearing using a scale map of the link path.  

 

When setting the antenna on the desired bearing ensure that you use the appropriate true-north to 
magnetic-north offset. Also ensure that the compass reading is not affected by standing too close 
to metallic objects. 

 

 
 

2. Once the antenna is pointing at the remote antenna, tighten the nuts on the U-bolt or antenna 
clamp just enough to hold it in position. Leave the nuts loose enough so that small adjustments 
can still be made. Check that the antenna is still pointing in the correct direction. 

3. Move the antenna up or down until it is pointing directly at the remote site. 

4. Tighten the elevation and azimuth adjustment clamps. 

5. Mark the position of the antenna clamps so that the antenna can be returned to this rough aim 
point easily when accurately aligning the antennas. 

6. Repeat steps 1-5 at the opposite site. 
 

Note: Low gain antennas need less adjustment in elevation as they are simply aimed at the horizon. 
They should always be panned horizontally to find the peak signal. 
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Accurately aligning the antennas 
Once the antennas are visually aligned, accurately align both antennas by carefully making small 
adjustments while monitoring the RSSI. This will give the best possible link performance. 

 

Note: Remember that it is important to align the main radiation lobes of the two antennas to each 
other, not any side lobes. It may be easier to perform this procedure if you can communicate with 
someone at the remote site by telephone, mobile, or two-way radio. 

 

1. Connect a laptop PC running SuperVisor software and power up the terminals at both ends of the 
link. Select Link > Performance > Summary so that you can see the RSSI indication for the local 
terminal. Alternatively, use the RSSI test point on the front panel together with a multimeter (see 
"6Measuring the RSSI” on page 168). 

2. Move the antenna through a complete sweep horizontally (known as a 'pan') either side of the 
point established in the visual alignment process above. Note down the RSSI reading for all the 
peaks in RSSI that you discover in the pan. 

3. Move the antenna to the position corresponding to the maximum RSSI value obtained during the 
pan. Move the antenna horizontally slightly to each side of this maximum to find the two points 
where the RSSI drops slightly. 

4. Move the antenna halfway between these two points and tighten the clamp. 

5. If the antenna has an elevation adjustment, move the antenna through a complete sweep (known 
as a 'tilt') vertically either side of the point established in the visual alignment process above. Note 
down the RSSI reading for all the peaks in RSSI that you discover in the tilt. 

6. Move the antenna to the position corresponding to the maximum RSSI value obtained during the 
tilt. Move the antenna slightly up and then down from the maximum to find the two points where 
the RSSI drops slightly. 

7. Move the antenna halfway between these two points and tighten the clamp. 

8. Recheck the pan (steps 2-4) and tighten all the clamps firmly. 
 

 
 

9. Perform steps 1-8 at the remote site. 
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Measuring the RSSI 
Measure the RSSI value with a multimeter connected to the RSSI test port on the front of the terminal 
(see "Front panel connections and indicators" on page 27). 

1. Insert the positive probe of the multimeter into the RSSI test port, and clip the negative probe to 
the chassis of the terminal (earth). 

2. Pan and tilt the antenna until you get the highest VDC reading. The values shown in the table 
below relate the measured VDC to the actual received signal level in dBm regardless of bandwidth 
and frequency. 

 
RSSI test 
port value 

(VDC) 

RSSI 
reading 
(dBm) 

 RSSI test 
port value 

(VDC) 

RSSI 
reading 
(dBm) 

 RSSI test 
port value 

(VDC) 

RSSI 
reading 
(dBm) 

0.000 - 100   0.675 - 73  1.350 - 46 

0.025 - 99    0.700 - 72  1.375 - 45 

0.050 - 98    0.725 - 71  1.400 - 44 

0.075 - 97    0.750 - 70  1.425 - 43 

0.100 - 96    0.775 - 69  1.450 - 42 

0.125 - 95    0.800 - 68  1.475 - 41 

0.150 - 94    0.825 - 67  1.500 - 40 

0.175   - 93    0.850 - 66  1.525 - 39 

0.200   - 92    0.875 - 65  1.550 - 38 

0.225   - 91    0.900 - 64  1.575 - 37 

0.250   - 90    0.925 - 63  1.600 - 36 

0.275   - 89    0.950 - 62  1.625 - 35 

0.300   - 88    0.975 - 61  1.650 - 34 

0.325   - 87    1.000 - 60  1.675 - 33 

0.350   - 86    1.025 - 59  1.700 - 32 

0.375   - 85    1.050 - 58  1.725 - 31 

0.400   - 84    1.075 - 57  1.750 - 30 

0.425   - 83    1.100 - 56  1.775 - 29 

0.450   - 82    1.125 - 55  1.800 - 28 

0.475   - 81    1.150 - 54  1.825 - 27 

0.500   - 80    1.175 - 53  1.850 - 26 

0.525   - 79    1.200 - 52  1.875 - 25 

0.550   - 78    1.225 - 51  1.900 - 24 

0.575   - 77    1.250 - 50  1.925 - 23 

0.600 - 76  1.275 - 49  1.950 - 22 

0.625 - 75  1.300 - 48  1.975 - 21 

0.650 - 74  1.325 - 47  2.000 - 20 
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Synchronizing the terminals 
After you have completed the alignment of the two antennas, you must ensure the two terminals are 
synchronized.  

The terminals are synchronized when: 

 the OK LED is green, which indicates that no system alarms are present, and 
 the RX LED is green, which indicates a good signal with no errors, and  
 the TX LED is green, which indicates that there are no transmitter fault conditions. 

 

Checking performance 
The amount of testing performed on the completed installation will depend on circumstances. Some 
customers may need to prove to a local licensing regulatory body that the link complies with the 
license provisions. This may require special telecommunications test equipment to complete these 
tests. Most customers simply want to confirm that their data traffic is successfully passing over the link, 
or that the customer interfaces comply with known quality standard. 

However, the most important performance verification checks are: 

 Receive input level 
 Fade margin 
 Long-term BER 

 

Checking the receive input level 
The received signal strength at the local terminal is affected by many components in the system and 
has a direct relationship with the resulting performance of the link. A link operating with a lower than 
expected signal strength is more likely to suffer from degraded performance during fading conditions. 
The receive input level of a link is normally symmetrical (that is, similar at both ends). 

1. Compare the final RSSI figure obtained after antenna alignment with that calculated for the link. 

2. If the RSSI figure is in excess of 3 dB down on the predicted level, recheck and correct problems 
using the table below and then recheck the RSSI. Alternatively, recheck the link budget 
calculations. 

 
Possible cause Terminal(s) 

Is the terminal operating on the correct frequency? Local & remote 

Is the remote terminal transmit power correct? Remote 

Are all the coaxial connectors tight? Local & remote 

Is the antenna the correct type, that is, gain and frequency of operation? Local & remote 

Is the antenna polarized? Local & remote 

Is the antenna aligned? Local & remote 

Is the path between the terminals obstructed?  
 

Note: If following the above steps does not resolve the situation, contact Customer Support for 
assistance. 

 

3. Record the RSSI figure on the commissioning form.  

4. Repeat steps 1 to 2 for the other end of the link. 
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Checking the fade margin 
The fade margin is affected by many components in the system and is closely related to the received 
signal strength. A link operating with a lower than expected fade margin is more likely to suffer from 
degraded performance during fading conditions. A reduced fade margin can be due to operating the 
link too close to the noise floor, or the presence of external interference. The fade margin of a link can 
be asymmetrical (that is, different at each end). 

Possible causes of low fade margin are as follows: 

 

Problem Terminal 

Low receive signal strength (see above table) Local and Remote 

Interfering signals on the same, or very close to, the frequency of the 
local terminal receiver. 

Local 

Intermodulation products that land on the same or very close to the 
frequency of the local terminal receiver. 

Local or Remote 

Operating near the local receiver noise floor Local 

 

To check the fade margin: 

1. Confirm (and correct if necessary) the receive input level (see the previous test). 

Note: If the receive input level is lower than expected, the fade margin may also be low. 

 

2. Select Link > Performance > Summary and check the current BER of the link in its normal 
condition is better than 10-6 (If necessary, clear out any extraneous errors by clicking Reset 
Counters).  

3. Check the signal to noise (S/N) indication on the Link > Performance > Summary page. This 
shows the quality of the signal as it is being processed in the modem. It should typically be better 
than 30 dB. If it is less than 25 dB, it means that either the RSSI is very low or in-band interference 
is degrading the S/N performance. 

4. Temporarily reduce the remote site's transmit power using either an external attenuator or 
SuperVisor (Remote > Terminal > Basic). 

Note: Ideally, the transmit power of the remote site should be reduced by up to 20 dB, which will 
require the use of an external 50 ohm coaxial attenuator capable of handling the transmit power 
involved. In the absence of an attenuator, reduce the transmit power using SuperVisor. 

 

5. Check and note the current BER of the link in its now faded condition (Again, if necessary, clear 
out any extraneous errors (introduced by the power reduction step above) by clicking Reset 
Counters). 

6. Compare the unfaded and faded BER performance of the link (steps 2 and 4). Continue to reduce 
the remote transmit power until either the BER drops to 10-6 or the remote transmitter power has 
been reduced by 20 dB. 

Note: The fade margin of the link is expressed as a number (of dB) that the link can be faded 
(transmitter power reduced) without reducing the BER below operating specifications (1 * 10-6 
BER). A 20 dB fade margin is adequate for most links. 
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7. Record the fade margin and SNR results on the commissioning form. 

Note: If the transmit power is reduced using SuperVisor rather than an external attenuator, the 
fade margin should be recorded as “Greater than x dB” (where x = the power reduction). 

 

8. Restore the remote terminal transmit power to normal. 

9. Repeat steps 1 to 7 for the other end of the link. 

Note: If following all the guidelines above does not resolve the situation, contact Customer 
Support for assistance. 

 

Checking long-term BER 
The BER test is a measure of the stability of the complete link. The BER results of a link can be 
asymmetrical (that is, different at each end). 

1. Select Link > Performance > Summary and check the current BER and error counters of the link. 
(If necessary, clear out any extraneous errors by selecting Reset Counters).  

2. Wait 15 minutes, and check the BER display and error counters again. If there are a small number 
of errors and the BER is still better than 10-9, continue the test for 24 hours. If there are a 
significant number of errors, rectify the cause before completing the 24 hour test. 

Note: It is normal to conduct the BER test in both directions at the same time, and it is important 
that no further work be carried out on the equipment (including the antenna) during this period. 

 

3. The BER after the 24 hour test should typically be better than 10-8. 

4. Record the BER results on the commissioning form. 
 

Bit Error Rate tests 
A Bit Error Rate (BER) test can be conducted on the bench, (see “Bench setup” on page 37). 

Attach the BER tester to the interface port(s) of one terminal, and either another BER tester or a 
loopback plug to the corresponding interface port of the other terminal.  

This BER test can be carried out over the Ethernet, E1/T1, V.24 or HSS interfaces. It will test the link 
quality with regard to user payload data. 

Caution: Do not apply signals greater than -20 dBm to the antenna as they can damage the receiver. 
In a bench setup, there must be 60 - 80 dB at up to 2 GHz of 50 ohm coaxial attenuation (capable of 
handling the transmit power) between the terminals’ antenna connectors. 
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Additional tests 
Depending on license requirements or your particular needs, you may need to carry out additional 
tests, such as those listed below. 

Refer to the relevant test equipment manuals for test details. 

 
Test Test equipment required 

TX power output measurements (at TX and 
duplexer outputs) 

Power meter 

TX spectrum bandwidth Spectrum analyzer 

TX spectral purity or harmonic outputs Spectrum analyzer 

TX center frequency Frequency counter or spectrum analyzer 

Bulk capacity BER test BER tester 

LAN throughput or errors LAN tester 

G.703 / HDB3 waveforms Digital oscilloscope 

Serial interface BER BER tester 

Audio quality PCM4 or SINAD test set 
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Checking the link performance 
For a graphical indication of the link performance, you can use the constellation analyzer. 

The 'dots' are a graphical indication of the quality of the demodulated signal. Small dots that are close 
together indicate a good signal. If the dots become spaced further apart, this indicates that the signal 
quality is degrading. This signal quality degradation can be caused by low Rx signal level due to, for 
example: 

 external interference 
 failure of any of the following: modem, receiver, far end transmitter, an antenna (either end), a 

feeder or connector (for example, due to water damage) 
 path issues such as multi-path fading or obstructions 

To check the performance of the link using the constellation analyzer: 

1. Select Link or Local or Remote > Performance > Constellation.  

A blank constellation diagram appears: 

 
2. Click Start to start the constellation analyzer. 

While the constellation analyzer is running, the terminal will temporarily stop collecting error 
performance statistics. If you want to run the constellation analyzer anyway, click OK when you 
see this warning message: 

 
3. Click Stop to stop the constellation analyzer. 

The terminal automatically resumes collecting error performance statistics. 
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Viewing a summary of the link performance 
To view the performance summary for a terminal: 

Select Link or Local or Remote > Performance > Summary.  
 

 
 

Field Explanation 

Link Performance 

Correctable errors The total number of correctable blocks since the last reset 

Uncorrectable errors The total number of uncorrectable blocks since the last reset 

SNR (dB) The Signal to Noise Ratio of the link in dB 

RSSI (dBm) The Received Signal Strength Indication at the Rx input in dBm 

Errored seconds The total number of operational seconds with errored traffic since the last 
reset 

Error free seconds The total number of error free operational seconds since the last reset 

BER The system will report an estimated Bit Error Rate up to a maximum of 1 
x 10-12 

TX temperature The measured temperature in the transmitter module in °C 

RX temperature The measured temperature in the receiver module in °C 

Ethernet performance 

Transmitted packets The total number of transmitted Ethernet packets 

Received packets The total number of received Ethernet packets 

Received packet errors The total number of packets received with errors 

If you want to reset the error counters, click Reset Counters. 
 



Maintenance  |  175 
 

 

13. Maintenance 
There are no user-serviceable components within the terminal. 

All hardware maintenance must be completed by 4RF or an authorized service centre. 

Do not attempt to carry out repairs to any boards or parts. 

Return all faulty terminals to 4RF or an authorized service centre.  

For more information on maintenance and training, please contact Customer Services. 

 

Caution: Electro Static Discharge (ESD) can damage or destroy the sensitive electrical components in 
the terminal. 

 

Routine maintenance 
Every six or twelve months, for both ends of the link, you should record the RSSI and SNR levels as 
well as checking the following: 

Item What to check or look for 

Equipment shelter environment Water leaks 
Room temperature 
Excessive vibration 
Vermin damage 

Terminal mounting Firmly mounted 

Antenna cable connections Tight and dry 

Antenna cable and its supports Not loose or suffering from ultra-violet degradation 

Antenna and its mounting hardware Not loose, rusty or damaged 

Safety earth Connections tight 
Cabling intact 

DC system Connections tight 
Voltage in normal limits 

Batteries (if installed) Connections tight 
Electrolyte levels normal 

 
 



Maintenance  |  176 
 

 

Terminal upgrades 
You can upgrade all software for both terminals remotely (through a management network), which 
eliminates the need to physically visit either end of the link. 

The best method of upgrading a terminal is to use the TFTP server method (see “Upgrading the 
terminal using TFTP” on page 177). This method downloads all the required image files into the 
terminal and then activates the correct files following a terminal reboot. 

A terminal can also be upgraded by download all the required system software files (see “Upgrading 
the terminal by uploading system files” on page 182”). 
 

Upgrade process 
To minimize disruption of link traffic and prevent your terminals from being rendered inoperative, 
please follow the procedures described in this section together with any additional information or 
instructions supplied with the upgrade package. 

Before upgrading the terminal, ensure that you have saved the configuration file (see "Saving the 
terminal's configuration" on page 66) as well as the cross connection configuration (see "Saving cross 
connection configurations" on page 130). 

The Remote terminal upgrade process will be faster if the bandwidth allocated to the management 
ethernet capacity is maximized. 

The terminal software must be identical at both ends of the link. 

At the end of the terminal upgrade process, the versions of image files (kernel software, and firmware) 
that were in use before the upgrade are still in the terminal. You can restore them, if required, by 
editing the image tables and reactivating the old files (see “Changing the status of an image ” on page 
188). 
 

IMPORTANT NOTE: Ensure you are logged into the Near end terminal before you start an upgrade. 

 

Installing RF synthesizer configuration files 
If you are upgrading from software version 5_x_x or greater, refer to “Upgrading the terminal using 
TFTP” on page 177). 

If you are upgrading from a software version prior to 7_1_x, you will need to install new RF synthesizer 
files, refer to “Configuration files” on page 182. You can then upgrade the terminal using TFTP (on 
page 177). 
 

Frequency Band Synthesizer File(to be installed) 

300 MHz XE_300_400_synth.cfg 

400 MHz XE_300_400_synth.cfg 

700 MHz XE_600_700_800_900_synth.cfg 

800 MHz XE_600_700_800_900_synth.cfg 

900 MHz XE_600_700_800_900_synth.cfg 

1400 MHz XE_1400_synth.cfg 

2000 MHz XE_2000_2500_synth.cfg 

2500 MHz XE_2000_2500_synth.cfg 
 

If you are upgrading from software version 3_x_x or 4_x_x, refer to “Upgrading the terminal by 
uploading system files” on page 182.  
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Upgrading the terminal using TFTP 
Before upgrading the terminal, ensure that you have saved the configuration file (see "Saving the 
terminal's configuration" on page 66) as well as the cross connection configuration (see "Saving cross 
connection configurations" on page 130). 

 

Upgrading the terminal using the TFTP (Trivial File Transfer Protocol) server involves these steps: 

1. Run the TFTP server. 

2. Login to the Near end terminal / local terminal (see “IP addressing of terminals” on page 47). 

3. Run the TFTP upgrade process on the Remote terminal. 

4. Reboot the Remote terminal. 

5. Run the TFTP upgrade process on the Local terminal. 

6. Reboot the Local terminal. 

7. Clear the Java and web browser caches. 
 

Step 1: Run the TFTP server 
1. Double-click tftpd32.exe (located in the TFTPD directory) from the Aprisa CD supplied with the 

product. Leave the TFTPD32 application running until the end of the upgrade process. 
 

 
2. Click Settings and make sure that both SNTP server and DHCP server are not selected (no tick), 

and click OK. 

 
3. Click Browse and navigate to the root directory on the Aprisa CD (for example, D:\) supplied with 

the product, then click OK. 

 
4. Note down the IP address of the TFTP server (shown in the Server Interfaces drop-down list in the 

TFTPD32 window) as you will need it later. 
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Step 2: Log into the Local terminal 
Use SuperVisor to log into the Near end terminal (now the Local terminal) (see “IP addressing of 
terminals” on page 47) with either 'modify' or 'admin' privileges. 

 
Step 3: Run the TFTP upgrade process on the Remote terminal 
1. Select Remote > Maintenance > Upload > TFTP Upgrade. 
 

 
 

2. Enter the IP address of the TFTP server (that you noted earlier) 

3. Enter the version number of the software that you are upgrading to as a three digit number 
separated by underscores, for example, 7_3_2. 

4. Click Apply and check the TFTP server for download activity. 

The Upgrade Result changes from 'Executing' to either 'Succeeded' or 'Failed'. 

Note: This may take several minutes when upgrading the remote terminal. 

If the upgrade has failed: 

 The TFTP server IP address may be set incorrectly 
 The 'Current Directory' on the TFTP server was not pointing to the location of the upload config 

file e.g. 'Rel_7_3_2.cfg' . 
 There may not be enough free space in the image table to write the file. Inactive images can 

be deleted (and the terminal rebooted) to free up space for the new image (see “Changing the 
status of an image file” on page 188). 

 

Step 4: Reboot the Remote terminal 
Reboot the remote terminal before proceeding with the next step of the upgrade process (see 
“Rebooting the terminal” on page 189). 

1. Select Remote > Maintenance > Reboot and select [Hard Reboot] 

Communications to SuperVisor remote page will fail until the remote terminal reboot has 
completed. 
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Step 5: Run the TFTP upgrade process on the Local terminal. 
1. Select Local > Maintenance > Upload > TFTP Upgrade. 
 

 
 

2. Enter the IP address of the TFTP server (that you noted earlier) 

3. Enter the version number of the software (that you are upgrading to) for example, 7_3_2. 

4. Click Apply and check the TFTP server for download activity. 

The Upgrade Result changes from 'Executing' to either 'Succeeded' or 'Failed'. 

Note: This may take several minutes when upgrading the remote terminal. 

 
Step 6: Reboot the Local terminal 
Reboot the local terminal before proceeding with the next step of the upgrade process (see “Rebooting 
the terminal” on page 189). 

1. Select Local > Maintenance > Reboot and select [Hard Reboot] 

2. Log back into the Local terminal when the reboot has completed. 
 

Step 7: Clear the Java and web browser caches 
After upgrading the terminal you should clear the Java and web browser caches. The files stored in 
them may cause the SuperVisor and Cross Connections applications to display incorrectly.  
 

To clear the Java cache (Windows XP): 

1. Select Start > Control Panel. 
 

2. Select Java Plug-in 
 

 
 

3. Click the Cache tab. 

4. Click Clear and then click OK to confirm. 
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To clear your web browser cache (Mozilla Firefox 1.x and above): 

1. Select Tools > Options. 

2. Select Privacy and then click Cache. 
 

 
 

3. Click Clear to clear the cache, and then click OK to confirm. 



Maintenance  |  181 
 

 

To clear your web browser cache (Internet Explorer 6.x and above): 

1. Select Tools > Internet Options. 
 

 
 

2. On the General tab, click Delete Files, and then click OK to confirm. 
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Upgrading the terminal by uploading system files 
 

A terminal can also be upgraded by uploading specific system files: configuration files, kernel image 
files, software image files or firmware image files. 
 

Note: You should only upgrade components that need changing. It is not always necessary, for 
instance, to replace kernel or software files when upgrading a single firmware file. If interdependency 
exists between file types, this will be made clear in the documentation that accompanied the update 
package. 

 

Configuration files 
Configuration files (.cfg) are compressed archives containing a script to instruct the terminal on how to 
handle the other files in the archive. 

Uploading of configuration files can only be performed to the Local Terminal (not via the link to the 
Remote Terminal). 

 

RF synthesizer configuration files 
The RF synthesizer configuration archive contains files that provide values for the transmitter and 
receiver synthesizers to operate across the supported frequency bands. 

Synthesizer configuration filenames have the following format: 
 

XE_(frequency bands)_synth.cfg e.g. XE_300_400_synth.cfg 
 

Modem configuration files 
The Modem configuration archive contains files that provide values for the Modem to operate at the 
various supported channel sizes and modulation types. 

Modem configuration filenames have the following format: 
 

modem_(version number).cfg e.g. modem_7_1_4.cfg 
 
Cross-connect configuration files 
The Cross-connect configuration archive contains the Cross Connections application program that can 
be launched from within SuperVisor. 

Cross-connect configuration filenames have the following format: 
 

C-crossconnect_(version number).cfg e.g. C-crossconnect_7_1_4.cfg 
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To upload a configuration file: 

1. Select Local > Maintenance > Config Files > Upload Configuration 

2. Browse to the location of the file required to be uploaded into the terminal *.cfg. 

3. Click on Upload. 
 

 
 

The normal response is Succeeded if the file has been loaded correctly. 

A response of ‘Failed’ could be caused by: 

• Not enough temporary space in the filesystem to uncompress the archive and execute the script 

• A file or directory expected by the script not being present on the filesystem 
 

4. Reboot the terminal using a ‘Hard Reboot’ (see “Rebooting the terminal” on page 189). 
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Image Files 
 

Image files (.img) are loaded into the terminal and either contains code that is executed by the system 
processor, or contain instructions to configure the various programmable logic elements. The image 
file types that can be uploaded are: 

• Kernel image files 

• Software image files 

• Firmware image files 
 

Note: The Bootloader image file C-CC-B-(version number).srec and Flash File System image file C-
CC-F-(version number).img can only be changed in the factory. 

 

Uploading of image files can only be performed to the local terminal (not via the link to the remote 
terminal). 
 

To upload and activate an image file: 

1. Upload the required image file. 

If the Upload Status page show ‘executing’, then ‘writing to flash’, then ‘Succeeded’, then the file 
has been written into the image table correctly. 

 

 
 

If the Upload Status is ‘Failed’, there may not be enough free space in the image table to write the 
file. Inactive images can be deleted (and the terminal rebooted) to free up space for the new 
image (see “Changing the status of an image file” on page 188). 

 

2. Set the status of the image to ‘activate’ (see “Changing the status of an image ” on page 188). 

This actually sets the status to ‘Selected’ until after a terminal reboot. 

3. Reboot the terminal using a ‘Hard Reboot’ (see “Rebooting the terminal” on page 189). 

This activates the selected image. The image table status will now show ‘Active’. 

The previous image file status will now show as ‘Inactive’. 
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Kernel image files 
Kernel image files contain code that forms the basis of the microprocessor’s operating system. There 
can only ever be two kernel image files in the image table, the active and the inactive. 
Kernel filenames have the following format: 
 

C-CC-K-(version number).img e.g. C-CC-K-7_1_4.img 
 

To upload a kernel image file; 

1. Select Local > Maintenance > Upload > Kernel 

2. Browse to the location of the file required to be uploaded into the terminal *.img. 

3. Click on Upload. 
 

 
 

4. Activate the image (see “Changing the status of an image file” on page 188). 
 

5. Reboot the terminal using a ‘Hard Reboot’ (see “Rebooting the terminal” on page 189). 
 

Software image files 
Software image files contain code that forms the basis of the terminal’s application and management 
software (including the Web-based GUI). There can only ever be two software image files in the image 
table, the active and the inactive. 
Software image filenames have the following format: 
 

C-CC-R-(version number).img e.g. C-CC-R-7_1_4.img 
 

To upload a software image file; 

1. Select Local > Maintenance > Upload > Software 

2. Browse to the location of the file required to be uploaded into the terminal *.img. 

3. Click on Upload. 
 

 
 

Software image files may take one or two minutes to upload as they can be quite large (≈ 2 Mbytes). 
The size of this file has caused some Microsoft Internet Explorer proxy server setups to abort during 
the software update process. To avoid this problem, either set the proxy file size limit to 'unlimited' or 
avoid the use of the proxy altogether. 
 

4. Activate the image (see “Changing the status of an image file” on page 188). 
 

5. Reboot the terminal using a ‘Hard Reboot’ (see “Rebooting the terminal” on page 189). 
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Firmware image files 
Firmware image files contain instructions to configure the various programmable logic elements in the 
terminal. There can only ever be two firmware image files for the same HSC version in the image 
table, the active and the inactive. 
 

Firmware image filenames have the following format: 
 

C-fpga_Ef-x-y-z.img e.g. C-fpga_E5-0-6-4.img 
 

where f indicates the function (motherboard, interface card, etc). 

Function Number Function 

1 Motherboard 1 

2 Motherboard 2 

5 QJET 

7 Q4EM 

8 DFXO 

9 DFXS 

A Modem 

B QV24 

C HSS 
 

where x indicates the HSC (hardware software compatibility) version. 

Revision Number Revision 

0 revision A hardware 

1 revision B hardware 

2 revision C hardware 

3 revision D hardware 
 

where y indicates the firmware major revision number 

where z indicates the firmware minor revision number 
 

To upload a firmware image file; 

1. Select Local > Maintenance > Upload > Firmware 

2. Browse to the location of the file required to be uploaded into the terminal *.img. 

3. Click on Upload. 
 

 
 

4. Activate the image (see “Changing the status of an image file” on page 188). 
 

5. Reboot the terminal using a ‘Hard Reboot’ (see “Rebooting the terminal” on page 189). 
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Viewing the image table 
 

To view the image table: 

1. Select Link or Local or Remote > Maintenance > Image Table. 
 

 
 

The image table shows the following information: 

Heading Function 

Index A reference number for the image file 

Type The image is not currently being used by the system and could be deleted. 

Status The status of the image; 'Active', 'Inactive', ‘Selected’, ‘Current (de-selected)’ 

Image Size The image file size 

Version The image file name and version details 
 

Note: Configuration file details do not appear in the image table. 
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Changing the status of an image file 
 

To change the status of an image: 

1. Select Link or Local or Remote > Maintenance > Image Table. 
 

2. Select the image you wish to change and click Edit. 
 

 
 

3. On the Image Details, select the status from the Command drop-down list and click Apply. 
 

Status Function 

Active The image is currently being used by the system. 

Inactive The image is not currently being used by the system and could be deleted.

Selected The image is not currently being used by the system but has been 
activated and will become active following a terminal reboot. 

Current (deselected) The image is currently being used by the system but as another image has 
been selected, it will become inactive following a terminal reboot. 
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Rebooting the terminal 
The local or remote terminals can be rebooted by SuperVisor. 

You can specify a ‘Soft Reboot’ which reboots the terminal without affecting traffic or a ‘Hard Reboot’ 
which reboots the terminal (similar to power cycling the terminal). 

You can specify an immediate reboot or setup a reboot to occur at a predetermined time. 
 

To reboot the terminal: 

1. Select Link or Local or Remote > Maintenance > Reboot. 
 

 
 

2. Select the Reboot Type field: 
 

 None: 

Do nothing. 

 Soft Reboot: 

Reboots the software but should not affect customer traffic. 

 Hard Reboot: 

Reboots the systems and affects customer traffic. 
 

3. Select the Reboot Command field: 
 

 None: 

Do nothing. 

 Reboot Now: 

Execute the selected reboot now. 

 Timed Reboot: 

Set the Reboot Time field to execute the selected reboot at a later date and time. This feature can 
be used to schedule the resulting traffic outage for a time that has least customer impact. 

 Cancel Reboot: 

Cancel a timed reboot. 
 

4. Click Apply to execute the reboot or Reset to restore the previous configuration. 
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Support summary 
The support summary page lists key information about the terminal, for example, serial numbers, 
software version, frequencies and so on. 

To view the support summary: 

Select Link or Local or Remote > Maintenance > Support Summary. 
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Installing interface cards 
 

Caution: You must power down the terminal before removing or installing interface cards. 

 

Interface cards are initially installed in the factory to the customers’ requirements however, during the 
life of the product, additional interface cards may need to be installed.  
 

Unless the terminals are protected (see "Protected terminals" on page 163), installing new interface 
cards involves a substantial interruption of traffic across the link. Staff performing this task must have 
the appropriate level of education and experience; it should not be attempted by inexperienced 
personnel.  

 

To install an interface card: 
 

1. Switch off the power to the terminal. 
 

2. Prepare the terminal for new interface cards (see “Preparing the terminal for new interface cards” 
on page 192). 

 

3. Install the interface card (see “Installing an interface card” on page 194). 
 

4. Power up the terminal. 
 

5. Configure the slot (see “Configuring a slot” on page 196). 

A slot can be configured before installing a new interface card, or after the interface card is 
installed and the terminal power cycled. 

 

6. Configure the cross connections. (see "Configuring the traffic cross connections" on page 133) 
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Preparing the terminal for new interface cards 
To prepare the terminal for a new interface card: 

1. Remove the terminal from service by first switching off the terminal power. For an AC powered 
terminal, remove the AC power connector. For a DC powered terminal, switch off the DC circuit 
breaker or supply fuse. 

 

2. Remove all other cables from the terminal, marking their locations first, if necessary, to aid later 
restoration. The safety earth connection must be the last cable removed. 

 

3. Ensure you have unobstructed access to the top and front of the terminal. Remove the terminal 
from the equipment rack, if required. 

 

4. Remove the top cover of the terminal by removing two socket screws from the rear. 

Note: The top cover slides back towards the rear of the chassis. 

 

5. Remove the front fascia by removing the four front panel socket screws. 

Note: The front fascia first hinges out to clear the antenna connector and earth stud, and is then 
removed by unclipping from the chassis and sliding downwards. See illustration below. 
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6. Remove the card securing screw from the required interface slot. 

7. There are two types of interface slot blanking plates, the seven tab break off and the single slot 
type (newer type). 

If the blanking plate is the seven tab break off, remove the slot blanking tab by folding the tab to 
and fro until it breaks off. 

 

 
 

If the blanking plate is the single slot type, unclip the blanking plate from behind the slot (assuming 
that the card securing screw has already been removed). 
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Installing an interface card 
To install an interface card: 

1. Remove the interface card from its packaging and static-safe bag. 

Caution: To avoid static damage to the terminal or the interface card being installed, use a static 
discharge wristband or similar antistatic device. 

 

2. Offer the interface card into the chassis at an angle until the front panel of the card engages in the 
chassis. 

 
3. Rotate the card in the chassis until it is level, and both parts of the card interface bus connector 

engage with the socket. Push down evenly on the interface card to seat it into the socket. 
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4. Replace the card securing screw. 
 

 
 

Note: Some interface cards may not have the bracket to accept the card securing screw. 

 

5. Replace the fascia and top covers, restore all cables, and power up the terminal. 
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Configuring a slot 
1. Select Link or Local or Remote > Interface > Slot Summary. 
 

 
 

2. Select the required slot and click Configure Slot. 
 

 
 

'Slot' shows the slot the interface card is plugged into in the terminal (A – H). 

Details of the interface card currently installed in the slot are: 

'H/W’ (hardware revision). 

'F/W’ (firmware revision) 

'HSC’ (hardware software compatibility) A number used by the system software to determine 
which FPGA ‘firmware image file’ to use in the interface card installed. 

 

‘Installed’ field shows the actual interface card installed in the slot. If there is no interface card 
installed in the slot, this field will show ‘none’. 

‘Expected’ shows interface card type that had been previously installed. Interface cards can be 
setup before they are installed in the terminal or after they are installed in the terminal. 

 

3. To setup a new interface card in a slot, select the interface card type you want to fit (or has been 
fitted) from the ‘Expected’ drop-down menu. 

Note: The transmitter, receiver and modem are configured in other sections (see "Configuring the 
terminal" on page 61). 

 

4. Click Apply to apply changes or Reset to restore the previous configuration. 
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14. Troubleshooting 
Loopbacks 
Loopbacks are used as a tool for testing or as part of the commissioning process and will affect 
customer traffic across the link. 

The terminal supports three types of loopbacks:  

 RF radio loopback 
 Interface loopbacks, set at the interface ports 
 Timeslot loopbacks 

 

 
 

RF radio loopback 
The RF radio loopback provides a loopback connection between the radio Tx and radio Rx. Each 
terminal is looped back independently. 

All traffic entering the transmit stage of the local terminal is turned around and delivered to the receiver 
section. This loopback will affect all traffic through the terminal. 

To enable or disable the RF loopback: 

Select Link or Local or Remote > Maintenance > Loopbacks. 
 

 
 

 To enable the RF loopback, click the RF Loopback checkbox (tick the box). 
 

Note: An RF loopback will automatically disable after the period set (in seconds) in the Loopback 
Timeout field. The default entry is 3600 seconds (60 minutes). 

 

 To disable the RF loopback, click the RF Loopback checkbox (untick the box). 
 

Click Apply to apply changes or Reset to restore the previous configuration. 

Note: When the RF loopback is selected, both the RX and TX LEDs will flash. 
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Interface loopbacks 
The interface loopback provides a loopback connection for the customer-connected equipment. All 
traffic arriving from the customer interface is looped back. 

These loopbacks are applied on a port-by-port basis and can only be enabled on active ports i.e. has 
to be activated by assigning traffic to it by the Cross Connections application. 

The interface card green LED flashes while the loopback is active. 
 

Loopback type Description 

QJET 
(whole tributary) 

The QJET interface loopback will loop back the selected E1 / T1 port.  

QJET 
(individual timeslot) 

The Cross Connections application can loopback framed E1 / T1 timeslots 
(see " 6Timeslot loopbacks” on page 198).  

Q4EM port The Q4EM interface loopback will loop back the port 4 wire analogue path 
to the customer. 

DFXO port The DFXO interface loopback will loop back the port digital paths to return 
the port analogue signal back to the customer. 

DFXS port The DFXS interface loopback will loop back the port digital paths to return 
the port analogue signal back to the customer.  

HSS port The HSS interface loopback will loop back the port data to the customer. 

QV24 port The QV24 interface loopback will loop back the port data to the customer. 

Ethernet No loopback possible. 
 

Timeslot loopbacks 
You can loopback framed E1 / T1 timeslots in the Cross Connections application. 

1. Open the Cross Connections application. 
 

2. Right-click the timeslot you want to loop back. 
 

 
 

3. Select Timeslot Loopback - the looped timeslot will display in black: 
 

 



Troubleshooting  |  199 
 

 

Alarms 
The LEDs (OK, RX, and TX) on the front panel illuminate either orange or red when there is a fault 
condition: 

 
 Orange indicates a minor alarm that should not affect traffic across the link. 
 Red indicates a major alarm condition that could affect traffic across the link. 

A major or minor alarm can be mapped to the external alarm outputs (see “Configuring the external 
alarm outputs” on page 76).  

 

Diagnosing alarms 
To view the Alarm Summary and their current states: 

Select Link or Local or Remote > Alarms > Summary. 
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Alarm Explanation 

Synthesizer Status The selected transmit frequency is outside the tuning range of the 
transmitter synthesizer 

Modem Lock The terminal modem is not synchronized with the modem at the other end 
of the link 

TX Temp Shutdown The transmitter power amplifier temperature is greater than 75°C. The 
transmitter has shut down to prevent damage. 

TX Temp Warning The transmitter power amplifier temperature is greater than 70°C. The 
transmitter will continue to operate in this condition, but if the power 
amplifier temperature increases above 75°C, a major alarm condition is set 
and the transmitter will shut down to prevent further damage. 

TX AGC Voltage The transmitter power amplifier automatic gain control is out of limits for 
normal operation 

TX Reverse Power There is excessive reflected power at the transmitter port of the terminal, 
indicating a low return loss in the path between transmitter port and the 
antenna. 

TX Return Loss 
Status 

Indicates the difference between the transmitted power and the amount of 
power being reflected back into the terminal. The alarm will trigger when 
there is too much reflected power from the antenna that will degrade link 
performance. 

RX RSSI The RX RSSI alarm threshold is determined by the RSSI Thresholds for 
each of the modulation types (see “Configuring the RSSI alarm threshold” 
on page 73) 

Fan 1 The internal cooling fan 1 is not operating 

Fan 2 The internal cooling fan 2 is not operating 

External Input 1 -2 Indicates an active alarm state on the the external alarm input 

Alarm Output 1 - 4 Indicates an active alarm state on the the external alarm output 

MHSB Switch Indicates that the MHSB has switched over. The MHSB alarm is only shown 
if MHSB mode is enabled (see “Configuring the terminals for MHSB” on 
page 160). 

 

To view detailed alarm information: 

Select Link or Local or Remote > Alarms > Alarm Table 
 

 
 

The Alarm Table shows the source of the alarm and the type, the slot (and port, if applicable) where 
the alarm originated, the severity and the date and time the alarm occurred.  

To further diagnose the cause of the alarm (see “Identifying causes of alarms” on page 204, and 
“Alarm types” on page 229). 
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Viewing the alarm history 
The alarm history page shows the historical alarm activity for up to 50 alarms. This page refreshes 
every 30 seconds.  

 

To view the alarm history: 

Select Link or Local or Remote > Alarms > Alarm History. 
 

 
 

Field Explanation 

Source The component within the terminal that generated the alarm 

Type The type of alarm (see "Alarm types and sources" on page 229) 

Slot The slot where the alarm originated, if applicable 

Port The port where the alarm originated, if applicable 

Severity Whether the alarm was a major or minor alarm 

Status Whether the alarm is active or cleared 

Time The date and time when the alarm occurred 

 

To clear the alarm history: 

Select Local or Remote > Alarms > Clear History 

The alarm history for up to 100 alarms can be seen using SNMP (see “SNMP (Simple Network 
Management Protocol)” on page 67). 
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Viewing interface alarms 
To view the alarms for a particular interface: 

1. Select Link or Local or Remote > Interface > Interface Summary. 

2. Select the desired interface card slot from the Interface Summary and click Alarms. 

This opens a page as shown below with a summary of the alarms on the interface card: 
 

 
 

The following fields are displayed: 
 Source: The type of interface card that generated the alarm 
 Type: The type of interface alarm 
 Slot: The slot of the interface card that generated the interface alarm 
 Port: The port that generated the interface alarm 
 Severity: Whether the interface alarm was major or minor 

 

3. Return to the Interface Summary page by either selecting Options > Interface Summary or clicking 
Back in the browser window. 
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Clearing alarms 
Select Link or Local or Remote > Alarms > Clear Alarms 
 

 
 

MHSB Command 
If a MHSB switchover event occurs, the OK LED on the front panel changes to orange. 

To clear the MHSB switchover alarm: 

Select Clear Switched Alarm from the MHSB Command drop-down list and click on Apply. 
 

Image Table Alarm 
An image table alarm appears if a problem occurred during the boot process which may have left the 
image table in an inconsistent state.  

To clear the two types of image table alarms: 

 The alternate image table alarm: this indicates that a backup image table has been used. This will 
match the actual image table unless immediately following a software upgrade.  

 The default image table alarm: this indicates that the image table has been rebuilt from defaults. In 
some circumstances this will mean that an incorrect build of software is running on the terminal.  

In either case, in addition to clearing the image table alarm, you should verify that the active images in 
the image table are correct for their software release. 
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Identifying causes of alarms 
 

The following are possible causes of an alarm. 

LED Colour Possible causes 

OK Orange A minor system alarm is set 

 Red A major system alarm is set 

RX Orange Low RSSI or AGC limits have been exceeded 

 Red Receiver power supply or synthesizer failure 

TX Orange AGC, transmitter temperature, forward power or reverse power limits have 
been exceeded 

 Red Transmit power supply or synthesizer failure 
 

OK LED 

Colour Alarm condition Suggested action 

Orange Fan failure Check that the fans are not blocked and can spin freely. 

Orange Interface card 
mismatch 

Using SuperVisor, check that the expected interface card and the 
fitted interface card are the same. 

Red Modem lock A modem lock alarm is generally seen when other conditions such 
as low RSSI are present. If there are no other alarms indicated, 
check the following: 
The terminal clocking is set up correctly. 
Both terminals are using the same modulation. 
Both terminals are using the same version of software. 
External RF Interference from equipment operating in adjacent 
channels. 
Check the constellation pattern for evidence of disturbances in the 
RF path. 
Compare RSSI with the expected values from the original path 
engineering calculation. Investigate any large differences. 
If the fault persists, contact your local representative. 

Red Interface alarms Check that the E1 or Ethernet interface cables are fitted correctly 
and the equipment they are connected to is functioning correctly. 
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RX LED 

Colour Alarm condition Suggested action 

Orange Low RSSI Check that all antenna and feeder cables are firmly connected 
and not damaged or kinked 
Check there is no damage to the antenna 
Check the TX power and alarm status of the remote terminal 

Orange Receiver AGC Contact your local 4RF representative 

Red Receiver power 
supply 

Contact your local 4RF representative 

 
TX LED 

Colour Alarm condition Suggested action 

Orange Reverse power Check that all antenna and feeder cables are firmly connected 
and not damaged or kinked 
Check there is no damage to the antenna 
Check that the Receiver and Transmitter ports are correctly 
connected to the High and Low ports of the duplexer 

Red Transmitter 
temperature 

Check operation of cooling fan or fans 
Ensure the air grills on the sides of the terminal are clear 
Ensure the ambient air temperature around the equipment is less 
than 50˚C 
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E1 / T1 alarm conditions 
The QJET interface yellow LED indicates: 

 Loss of signal (LOS) 

A loss of signal alarm occurs when there is no valid G.703 signal at the E1 / T1 interface RX input 
from the downstream system. 

This alarm masks the LOF and AIS received alarms. 
 

 Loss Of Frame alignment (LOF) 

A loss of frame alignment alarm occurs when the E1 / T1 interface RX input receives a valid G.703 
signal (code and frequency) but does not receive a valid G.704 signal i.e. no frame alignment 
word, from the downstream system (in framed E1 / T1 modes only) (red alarm in framed T1 
modes). 

This alarm masks the AIS received alarm. 
 

 Alarm Indication Signal (AIS) 

An AIS received alarm occurs when AIS is received from the downstream system. 

An E1 / T1 interface will output AIS to the downstream system if the normal upstream traffic signal 
is not available e.g. loss of modem synchronization, loss of RF signal across the link (blue alarm in 
framed T1 modes).  

 

 Remote Alarm Indicator (RAI) 

A remote alarm indicator occurs when RAI is received from the downstream system when it has 
an active LOS or LOF alarm (TS0 NFAS bit 3 in framed E1 modes and yellow alarm in framed T1 
modes). 

 

 TS16 Loss of signal (TS16LOS) 

A TS16 loss of signal alarm occurs when there is no valid TS16 signal at the E1 interface RX input 
from the downstream system (in E1 PCM 30 modes only). 

 

 TS16 Remote Multi-frame Alarm Indicator (RMAI) 

A remote multiframe alarm indicator occurs when RMAI is received from the downstream system 
when it has an active TS16LOS alarm  (TS16 F0 bit 6 in E1 PCM 30 modes only). 

 

 TS16 Alarm Indication Signal (TS16AIS) 

A TS16 Alarm Indication Signal alarm occurs when AIS is received from the downstream system 
in TS16. 

An E1 interface will output the TS16 AIS signal to the downstream system if the normal TS16 
multi-frame signal is not available  (in E1 PCM 30 modes only). 

 

The QJET interface green LED indicates: 

The QJET interface green LED flashes when the E1 / T1 port loopback is active. 
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System log 
 

SuperVisor automatically keeps a log, known as 'syslog', which captures all alarms, errors and events 
for each terminal.  

You can specify that the ‘syslog’ is saved to a particular file (see " 6Setting up for remote logging” on 
page 209). You can then email this file to customer service, if requested, to enable them to fault-find 
more accurately. 

Checking the syslog 
To view the Syslog: 

1. Select Local > Performance > Logging > Syslog. 

This opens a new window: 
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2. The system log is quite hard to decipher in Internet Explorer. If you're using Internet Explorer, 
select View > Source, which opens the file in a more legible layout in Notepad (see illustration 
below). Save or print this file, as required. 

 

 
 

3. If you want to save the system log, you can save it from within Notepad (or Internet Explorer). 
Select File > Save As. Navigate to where you want to save the file. Enter a meaningful filename 
and select 'Text File' from the Save As Type drop-down list. Click Save. 

 

You can specify that this file is automatically saved to a computer (see "6Setting up for remote logging” 
on page 209). 
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Setting up for remote logging 
Note: When setting up to save the system log to a specific computer, be aware that the file is 
constantly updated and may get quite large quite quickly. 

 

To set up a terminal for remote logging: 

1. Copy the TFTP server application (tftpd32.exe, which is located in the TFTPD directory) from the 
terminal product CD into a suitable directory on the PC (for example, C:\Program Files\TFTP 
Server). 

2. Create another directory where you want the system logs to be saved for example; 

C:\Aprisa XE Syslog 

3. Double-click tftpd32.exe. 
 

 
 

4. Click Settings and make sure that both ‘Syslog Server’ and ‘Save syslog message’ boxes are 
ticked. 

 

 
 

5. Click Browse and select a directory where you want the Syslog file to be saved (created in step 2). 
 

6. Click OK to close the Settings dialog box. 
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7. In SuperVisor, select Link or Link or Local or Remote > Terminal > Advanced. 
 

 
 

8. In the Remote Syslog Address field, enter the IP address of the PC on which the Syslog server is 
running. 

 

9. In the Remote Syslog Port field, enter 514. 
 

10. Reboot the terminal (Link or Local or Remote > Maintenance > Reboot).  
 

11. Open the directory where the system logs are being saved to. You should see a file called 
syslog.txt. 
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15. Interface connections 
RJ-45 connector pin assignments 
 

 
RJ-45 pin numbering 

 
 

Interface traffic direction 
All interface traffic directions and labels used in this manual refer to the direction relative to the 
terminal. Refer to the diagram below. 

The traffic direction describes the transmit / receive paths and the direction of handshaking and 
clocking signals, depending on the interface. 
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QJET Interface connections 
 

Pin 
number 

Pin function Direction TIA-568A wire 
colour 

1 Transmit Output Green/white 

2 Transmit Output Green 

3 Not used  Orange/white 

4 Receive Input Blue 

5 Receive Input Blue/white 

6 Not used  Orange 

7 Not used  Brown/white 

 
8 Not used  Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green On Normal operation 

Yellow On Loss of signal (LOS) or 
Alarm Indication Signal (AIS) or 
Loss Of Frame alignment (LOF) in Framed 
modes 

Green Flashing Port in loopback 

The standard QJET interface is 120 ohm balanced. 

External Balun transformers can be used to provide a 75 ohm unbalanced interface. 
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Ethernet interface connections 
 

Pin 
number 

Pin function Direction TIA-568A wire 
colour 

1 Transmit Output Green/white 

2 Transmit Output Green 

3 Receive Input Orange/white 

4 Not used  Blue 

5 Not used  Blue/white 

6 Receive Input Orange 

7 Not used  Brown/white 

 

8 Not used  Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green On Ethernet activity 
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Q4EM Interface connections 
 

Pin 
number 

Pin function Direction TIA-568A wire 
colour 

1 M Input Green/white 

2 M1 Input Green 

3 Receive (Ra/R) Input Orange/white 

4 Transmit (Tb/R1) Output Blue 

5 Transmit (Ta/T1) Output Blue/white 

6 Receive (Rb/T) Input Orange 

7 E Output Brown/white 

 
8 E1 Output Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green On Normal operation (M signal) 

Yellow On Alarm condition (E signal) 

Green Flashing Port in loopback 
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E&M Signalling types 
 
 

The Q4EM E&M signalling leads are optically isolated, bi-directional lines which can be externally 
referenced to meet any of the EIA-464 connection types I, II,IV or V (as shown below). 

The M1 lead associated with the M wire detector can be externally referenced to earth or battery as 
required. 

The E1 lead associated with the E wire output can be externally referenced to earth or battery as 
required. 
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DFXS Interface connections 
 

 

The subscriber interface connects the terminal to the customer's 2 wire 
telephone via a 2 wire line. 
Each 2 wire channel has two access points: one connects to a customer; the 
other is a local test port. 
 

 

Warning: If there is a power failure at either terminal, any 
telephone connected at the DFXS will not operate. 

Please ensure that a separate telephone that is not 
dependent on local power is available for use in an 
emergency. 

 

 

RJ-45 Pin number Pin function Direction TIA-568A wire 
colour 

1 Not used  Green/white 

2 Not used  Green 

3 Not used  Orange/white 

4 Ring Bi-directional Blue 

5 Tip Bi-directional Blue/white 

6 Not used  Orange 

7 Not used  Brown/white 

 

8 Not used  Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green On Normal operation 

Yellow Flashing Loopback in place 

Yellow On Alarm condition 

Both LEDs Flashing Loss of CAS signals 
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DFXO Interface connections 
 

 

The DFXO interface connects the terminal to the telephone network via a 2 wire 
line. 

Each DFXO channel has two access points: one connects to a customer; the 
other is a local test port. 

 

 

RJ-45 Pin number Pin function Direction TIA-568A wire 
colour 

1 Not used  Green/white 

2 Not used  Green 

3 Not used  Orange/white 

4 Ring Bi-directional Blue 

5 Tip Bi-directional Blue/white 

6 Not used  Orange 

7 Not used  Brown/white 

 

8 Not used  Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green On Normal operation 

Yellow Flashing Loopback in place 

Yellow On Alarm condition 
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HSS Interface connections 
 

 

The connector on the high-speed synchronous serial interface is a high density 
LFH-60 (as used on standard Cisco WAN port serial interface cables and 
equivalents).  

The interface specification (X.21 / V.35 etc) is automatically changed by simply 
changing the type of interface cable connected to the HSS.  

 

LED indicators 

LED Status Explanation 

Top green LED On Normal operation 

Top green LED Flashing Loopback in place 

Lower green LED On Normal operation 
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Synchronous cable assemblies 
 

Sync EIA/TIA-232 for DTE (Part number: Cab Sync 232MT) 
 

Pin number Pin function Direction 

1 Ground - 

2 TXD Input 

3 RXD Output 

4 RTS Input 

5 CTS Output 

6 DSR Output 

7 Circuit DCD - 

8 DCD Output 

15 TXC Output 

17 RXC Output 

18 LTST Input 

20 DTR Input 

24 TXCE Input 
 

Sync EIA/TIA-232 Cable Assembly for DCE (Part number: Cab Sync 232FC) 
 

Pin number Pin function Direction 

1 GND - 

2 TXD Output 

3 RXD Input 

4 RTS Output 

5 CTS Input 

6 DSR Input 

7 Circuit Ground - 

8 DCD Input 

15 TXC Input 

17 RXC Input 

18 LTST Output 

20 DTR Output 

24 TXCE Output 
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EIA/TIA-449 Serial Cable Assembly for DTE (Part number: Cab Sync 449MT) 
 

Pin number Pin function Direction 

1 Shield Ground - 

4 
22 

SD+ 
SD- 

Input 
Input 

5 
23 

ST+ 
ST- 

Output 
Output 

6 
24 

RD+ 
RD- 

Output 
Output 

7 
25 

RS+ 
RS- 

Input 
Input 

8 
26 

RT+ 
RT- 

Output 
Output 

9 
27 

CS+ 
CS- 

Output 
Output 

10 
37 

LL 
SC 

Input 
_ 

11 
29 

DM+ 
DM- 

Output 
Output 

12 
30 

TR+ 
TR- 

Input 
Input 

13 
31 

RR+ 
RR- 

Output 
Output 

17 
35 

TT+ 
TT- 

Input 
Input 

19 
20 

SG 
RC 

- 
- 
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EIA/TIA-449 Serial Cable Assembly for DCE (Part number: Cab Sync 449FC) 
 

Pin number Pin function Direction 

1 Shield Ground _ 

4 
22 

SD+ 
SD- 

Output 
Output 

5 
23 

ST+ 
ST- 

Input 
Input 

6 
24 

RD+ 
RD- 

Input 
Input 

7 
25 

RS+ 
RS- 

Output 
Output 

8 
26 

RT+ 
RT- 

Input 
Input 

9 
27 

CS+ 
CS- 

Input 
Input 

10 
37 

LL 
SC 

Output 
_ 

11 
29 

DM+ 
DM- 

Input 
Input 

12 
30 

TR+ 
TR- 

Output 
Output 

13 
31 

RR+ 
RR- 

Input 
Input 

17 
35 

TT+ 
TT- 

Output 
Output 

19 
20 

SG 
RC 

- 
- 
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V.35 Serial Cable Assembly for DTE (Part number: Cab Sync V35MT) 
 

Pin number Pin function Direction 

A Frame Ground  

B Circuit Ground  

C RTS Input 

D CTS Output 

E DSR Output 

F RLSD Output 

H DTR Input 

K LT Input 

P 
S 

SD+ 
SD- 

Input 
Input 

R 
T 

RD+ 
RD- 

Output 
Output 

U 
W 

SCTE+ 
SCTE- 

Input 
Input 

V 
X 

SCR+ 
SCR- 

Output 
Output 

Y 
AA 

SCT+ 
SCT- 

Output 
Output 

 

V.35 Serial Cable Assembly for DCE (Part number: Cab Sync V35FC) 
 

Pin number Pin function Direction 

A Frame Ground  

B Circuit Ground  

C RTS Output 

D CTS Input 

E DSR Input 

F RLSD Input 

H DTR Output 

K LT Output 

P 
S 

SD+ 
SD- 

Output 
Output 

R 
T 

RD+ 
RD- 

Input 
Input 

U 
W 

SCTE+ 
SCTE- 

Output 
Output 

V 
X 

SCR+ 
SCR- 

Input 
Input 

Y 
AA 

SCT+ 
SCT- 

Input 
Input 
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X.21 Serial Cable Assembly for DTE (Part number: Cab Sync X21MT) 
 

Pin number Pin function Direction 

1 Shield Ground - 

2 
9 

Transmit+ 
Transmit- 

Input 
Input 

3 
10 

Control+ 
Control- 

Input 
Input 

4 
11 

Receive+ 
Receive- 

Output 
Output 

5 
12 

Indication+ 
Indication- 

Output 
Output 

6 
13 

Timing+ 
Timing- 

Output 
Output 

8 Circuit Ground  
 

X.21 Serial Cable Assembly for DCE (Part number: Cab Sync X21FC) 
 

Pin number Pin function Direction 

1 Shield Ground - 

2 
9 

Transmit+ 
Transmit- 

Output 
Output 

3 
10 

Control+ 
Control- 

Output 
Output 

4 
11 

Receive+ 
Receive- 

Input 
Input 

5 
12 

Indication+ 
Indication- 

Input 
Input 

6 
13 

Timing+ 
Timing- 

Input 
Input 

8 Circuit Ground  
 



Interface connections  |  225 
 

 

EIA-530 Serial Cable Assembly for DCE (Part number: Cab Sync 530FC) 
 

Pin number Pin function Direction 

2 
14 

BA(A), TXD+ 
BA(B), TXD- 

Output 
Output 

3 
16 

BB(A), RXD+ 
BB(B), RXD- 

Output 
Outputcc 

4 
19 

CA(A), RTS+ 
CA(B), RTS- 

Output 
Output 

5 
13 

CB(A), CTS+  
CB(B), CTS- 

Input 
Input 

6 
22 

CC(A), DSR+  
CC(B), DSR- 

Input 
Input 

1 
- 

Shield 
- 

 

8 
10 

CF(A), DCD+ 
CF(B), DCD- 

Input 
Input 

15 
12 

DB(A), TXC+ 
DB(B), TXC- 

Input 
Input 

17 
9 

DD(A), RXC+ 
DD(B), RXC- 

Input 
Input 

18 
7 

LL  
Circuit Ground 

Output 
- 

20 
23 

CD(A), DTR+ 
CD(B), DTR- 

Output 
Output 

24 
11 

DA(A), TXCE+ 
DA(B), TXCE- 

Output 
Output 

25 TM, not used Output 
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EIA-530 Serial Cable Assembly for DTE (Part number: Cab Sync 530MT) 
 

Pin number Pin function Direction 

2 
14 

BA(A), TXD+ 
BA(B), TXD- 

Input 
Input 

3 
16 

BB(A), RXD+ 
BB(B), RXD- 

Output 
Output 

4 
19 

CA(A), RTS+ 
CA(B), RTS- 

Input 
Input 

5 
13 

CB(A), CTS+  
CB(B), CTS- 

Output 
Output 

6 
22 

CC(A), DSR+  
CC(B), DSR- 

Output 
Output 

1 
- 

Shield 
- 

 

8 
10 

CF(A), DCD+ 
CF(B), DCD- 

Output 
Output 

15 
12 

DB(A), TXC+ 
DB(B), TXC- 

Output 
Output 

17 
9 

DD(A), RXC+ 
DD(B), RXC- 

Output 
Output 

18 
7 

LL  
Circuit Ground 

Input 
- 

20 
23 

CD(A), DTR+ 
CD(B), DTR- 

Input 
Input 

24 
11 

DA(A), TXCE+ 
DA(B), TXCE- 

Input 
Input 

25 TM, not used Input 
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Cable WAN connectors 
 

Cisco LFH-60 
cable name 

WAN connector Connector gender Label on WAN end 

232FC DB-25 female 'to DTE' 

232MT DB-25 male 'to DCE' 

449FC DB-37 female 'to DTE' 

449MT DB-37 male 'to DCE' 

V35FC M34 female 'to DTE' 

V35MT M34 male 'to DCE' 

X21FC DB-15 female 'to DTE' 

X21MT DB-15 male 'to DCE' 

530FC DB-25 female 'to DTE' 

530MT DB-25 male 'to DCE' 
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QV24 Interface connections 
 

Pin number Pin function Direction TIA-568A wire 
colour 

1 RTS Input Green / white 

2 DTR Input Green 

3 TXD Input Orange / white 

4 Ground  Blue 

5 DCD / Ground Input Blue / white 

6 RXD Output Orange 

7 DSR Output Brown / white 
 8 CTS Output Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green On / flashing Transmit data 

Yellow On / flashing Receive data 
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16. Alarm types and sources 
Alarm types 
Note: If you need to contact customer support about any of these alarms, please supply the reference 
number. 

Transmitter alarms 
Ref Type Explanation 

A1 txADCChZeroHi The transmitter AGC voltage is high 

A2 txADCChZeroLo The transmitter AGC voltage is low 

A3 txADCChOneHi The transmitter Forward Power Monitor reading is high 

A4 txADCChOneLo The transmitter Forward Power Monitor reading is low 

A5 txADCChTwoHi The transmitter Reverse Power Monitor reading is high 

A6 txADCChTwoLo The transmitter Reverse Power Monitor reading is low 

A7 txADCChThreeHi The transmitter temperature is greater than 75°C and the 
transmitter has shut down 

A8 txADCChElevenHi The transmitter temperature is greater than 70°C. 

A9 txADCChFourHi The transmitter synthesizer tuning voltage is high 

A10 txADCChFourLo The transmitter synthesizer tuning voltage is low 

A11 txADCChSevenHi The transmitter digital 5 VDC power supply voltage is high 

A12 txADCChSevenLo The transmitter digital 5 VDC power supply voltage is low 

A13 txADCChEightHi The transmitter reference 7 VDC power supply voltage is high 

A14 txADCChEightLo The transmitter reference 7 VDC power supply voltage is low 

A15 txADCChNineHi The transmitter 9 VDC power supply voltage is high 

A16 txADCChNineLo The transmitter 9 VDC power supply voltage is low 

A17 txADCChSixHi The transmitter 11 VDC power supply voltage is high 

A18 txADCChSixLo The transmitter 11 VDC power supply voltage is low 

A19 txADCChFiveHi The transmitter 28 VDC power supply voltage is high 

A20 txADCChFiveLo The transmitter 28 VDC power supply voltage is low 

A21 txSynthLD The transmitter synthesizer frequency is not set 

A22 tx5VFail The transmitter 5 VDC power supply has failed 

A23 tx11VFail The transmitter 11 VDC power supply has failed 

A24 tx28VFail The transmitter 28 VDC power supply has failed 

A25 txEEFail The transmitter on-board memory has failed 

A26 txTSensorFail The transmitter temperature sensor has failed 

A27 txReturnLoss The transmitter return loss is high 

A28 txAmplifierBalance One side of the transmitter amplifier has failed 

A29 txMibFail The transmitter MIB is corrupt in EEPROM 

A30 txADCChSixHi The transmitter VCO voltage is high 

A31 txADCChSixLo The transmitter VCO voltage is low 

A32 txADCChEightHi The transmitter digital -5 VDC power supply voltage is high 

A33 txADCChEightLo The transmitter digital -5 VDC power supply voltage is low 
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Receiver alarms 
Ref Type Explanation 

B1 rxADCChEightHi The AGC voltage is high 

B2 rxADCChEightLo The AGC voltage is low 

B3 rxRSSIHi The receiver maximum input level has been exceeded 

B4 rxRSSILo The RSSI is below the alarm threshold setting (see page 73) 

B5 rxADCChSixHi The synthesizer tuning voltage is high 

B6 rxADCChSixLo The synthesizer tuning voltage is low 

B7 rxADCChSevenHi The -1.5 VDC power supply is high 

B8 rxADCChSevenLo The -1.5 VDC power supply is low 

B9 rxADCChTwoHi The 3.3 VDC power supply is high 

B10 rxADCChTwoLo The 3.3 VDC power supply is low 

B11 rxADCChOneHi The digital 5 VDC power supply voltage is high 

B12 rxADCChOneLo The digital 5 VDC power supply voltage is low 

B13 rxADCChZeroHi The 9 VDC power supply voltage is high 

B14 rxADCChZeroLo The 9 VDC power supply voltage is low 

B15 rx12VFail The 12 VDC power supply has failed 

B16 rxSynthLD The synthesizer frequency is not set 

B17 rxEEFail The on-board memory has failed 

B18 rxADCChNineHi The 28 VDC power supply voltage is high 

B19 rxADCChNineLo The 28 VDC power supply voltage is low 

B20 rxOff The receiver is off 

B21 rxADCChFiveHi The receiver temperature is too high 

B22 rxMibFail The receiver MIB is corrupt in EEPROM 
 

MUX alarms 
Ref Type Explanation 

C1 muxInit A MUX card failed to program 

C2 muxMibEEFail The MIB EEROM is corrupt 

C3 muxCharEEFail The character data is corrupt 
 

Modem alarms 
Ref Type Explanation 

D1 mdLOS The modem has loss of synchronization with the far end 

D2 mdDemodAlignmentLost The modem is unable to synchronize to the payload framing 

D3 mdTdmAlignmentLost The modem is unable to synchronize to the system bus timing 

D4 mdRefAFail The modem reference clock A has failed 

D5 mdRefBFail The modem reference clock B has failed 

D6 mdClkSyncFail The modem is unable to synchronize to the system clock 

D7 mdEEFail The modem EEPROM is corrupt 
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Motherboard alarms 
Ref Type Explanation 

E1 mbFan1Fail Fan 1 failure 

E2 mbFan2Fail Fan 2 failure 

E3 mbCardMismatch The expected interface card is different to the card that is 
fitted 

E4 mbHwHsc A MUX card has an unsupported HSC number 
 

QJET alarms 
Ref Type Explanation 

F1 e1AIS The E1 interface RX input has received an Alarm Indication 
Signal from the downstream equipment. 

F2 e1RAI The E1 interface interface RX input has received a Remote 
Alarm Indication alarm (RAI) from the downstream equipment. 
A remote alarm indicator signal is sent from the downstream 
equipment when it has an active LOS or LOF alarm. 

F3 e1LOS The E1 interface Loss Of Signal alarm (LOS) 

F4 e1CRC4 The E1 interface Cyclic Redundancy Check 4 alarm indicates 
a loss of or corrupted CRC data. 

F5 e1LOF The E1 interface Loss Of Frame alignment (LOF) 

F6 e1RMAI The E1 interface interface RX input has received an RMAI 
from the downstream equipment. 
A TS16 remote alarm indicator signal is sent from the 
downstream equipment when it has an active TS16 LOS or 
LOF alarm. 

F7 e1TS16AIS The E1 interface RX input has received a TS16 Alarm 
Indication Signal from the downstream equipment. 

F8 e1TS16LOS The E1 timeslot 16 Loss Of Signal alarm 

F9 t1AIS The T1 interface RX input has received an Alarm Indication 
Signal from the downstream equipment (AIS Received alarm) 

F10 t1RAI The T1 interface interface RX input has received a Remote 
Alarm Indication alarm (RAI) from the downstream equipment. 

F11 t1LOS The T1 interface Loss Of Signal alarm (LOS) 

F12 t1LOF The T1 interface Loss Of Frame alignment (LOF) 
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DFXO alarms 
Ref Type Explanation 

G1 fxoCodecOvld Codec receive signal overload detected 

G2 fxoBillToneOvld Billing tone overload detected 

G3 fxoUnplug Exchange line unplugged from interface 

G4 fxoCurrentOvld Loop current overload detected (greater than 100 mA) 
 

DFXS alarms 
Ref Type Explanation 

H1 fxsCalibError The phone was off-hook during the initialization phase 

H2 fxsDCDCError DC-DC converter low battery voltage error 

H3 fxsCasLock Loss of CAS lock 
 

HSS alarms 
Ref Type Explanation 

J1 hssLoss Loss of control pattern 

J2 hssRxFifoFull HSS RX FIFO overrun 

J3 hssRxFifoEmpty HSS RX FIFO underrun 

J4 hssTxFifoFull HSS TX FIFO overrun 

J5 hssTxFifoEmpty HSS TX FIFO underrun 

J6 hssRxClockInvalid The RX clock is invalid 

J7 hssTxClockInvalid The TX clock is invalid 
 

QV24 alarms 
Ref Type Explanation 

K1 v24CtrlLineLoss The V.24 control lines are not in sync 
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External alarm inputs 
Ref Type Explanation 

L1 externalAlarm1 There has been an alarm on external alarm input 1 

L2 externalAlarm2 There has been an alarm on external alarm input 2 
 

Remote terminal alarms 
Ref Type Explanation 

M1 remoteMajorAlarm There has been a major alarm on the remote terminal 

M2 remoteMinorAlarm There has been a minor alarm on the remote terminal 
 

Cross connect alarms 
Ref Type Explanation 

N1 ccNoBandwidth There is insufficient bandwidth for the current cross 
connection configuration 

 

MHSB alarms 
Ref Type Explanation 

P1 mhsbSwitchToStandby The terminal has switched from active to standby 
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17. Country specific settings 
The following table shows the country-specific settings for the DFXO / DFXS interface cards. If the 
country you want is not listed, contact the local telephone company for assistance. 

Country DFXO / DFXS Termination / balance 
impedance 

DFXO 
loop 
current 
limiter 

DFXO 
on-hook 
speed 

DFXO 
ringing 
impedance 

DFXO 
ringing 
detection 
threshold 

Argentina 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Australia TN12 220Ω + (820Ω ║ 120nF) On 26 ms > 10 MΩ 16 Vrms 

Austria TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Bahrain TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Belgium TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Brazil 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Bulgaria 220Ω + (820Ω ║ 120nF) On 3 ms > 10 MΩ 16 Vrms 

Canada 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Chile 600Ω On < 500 μs > 10 MΩ 16 Vrms 

China 600Ω and 
China 200Ω + (680Ω ║ 100nF) 

On < 500 μs > 10 MΩ 16 Vrms 

Colombia 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Croatia  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Cyprus TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Czech Republic TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Denmark TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Ecuador 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Egypt TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

El Salvador  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Finland TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

France TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Germany TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Greece TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Guam 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Hong Kong 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Hungary TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Iceland TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

India  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Indonesia  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Ireland  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Israel  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Italy  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Japan  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Jordan  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Kazakhstan  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Kuwait  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Latvia  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Lebanon  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Luxembourg  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 
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Macao  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Malaysia 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Malta  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Mexico  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Morocco  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Netherlands  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

New Zealand  BT3 (370Ω + (620Ω ║ 310nF)) On < 500 μs > 10 MΩ 16 Vrms 

Nigeria  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Norway TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Oman  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Pakistan  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Peru 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Philippines  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Poland  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Portugal  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Romania  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Russia 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Saudi Arabia  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Singapore  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Slovakia  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Slovenia  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

South Africa  TBR21 270Ω + (750Ω ║ 150nF) On < 500 μs 30 kΩ 16 Vrms 

South Korea  600Ω On < 500 μs 30 kΩ 16 Vrms 

Spain  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Sweden TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Switzerland  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 10 MΩ 16 Vrms 

Taiwan 600Ω On < 500 μs > 10 MΩ 16 Vrms 

Thailand 600Ω On < 500 μs > 10 MΩ 16 Vrms 

UAE  600Ω On < 500 μs > 10 MΩ 16 Vrms 

UK BT Network 320Ω + (1050Ω ║ 230nF) 
and TBR21 270Ω + (750Ω ║ 150nF) 

On 3 ms > 10 MΩ 16 Vrms 

USA  600Ω On < 500 μs > 10 MΩ 16 Vrms 

Yemen  600Ω On < 500 μs > 10 MΩ 16 Vrms 
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18. Specifications 
RF specifications 
 

Frequency Bands ETSI R1 Frequency
Band

Frequency
Band Limits

Synthesizer
Step Size

300 MHz band 330 - 400 MHz 6.25 kHz

400 MHz band 400 - 470 MHz 6.25 kHz

600 MHz band 620 - 715 MHz 12.5 kHz

  700 MHz band 698 - 806 MHz 25 kHz

800 MHz band 805 - 890 MHz 25 kHz

900 MHz band 850 - 960 MHz 25 kHz

1400 MHz band 1350 - 1550 MHz 12.5 kHz

2000 MHz band 1900 - 2300 MHz 62.5 kHz

2500 MHz band 2300 - 2700 MHz 62.5 kHz

Frequency Bands FCC R1 Frequency
Band

Frequency
Band Limits

Synthesizer
Step Size

400 MHz band 330 - 512 MHz 6.25 kHz

900 MHz band 850 - 960 MHz 25 kHz

Modulation

Frequency stability

Antenna connector

Note R1                   Contact 4RF for other frequency options

16 / 32 / 64 QAM and QPSK (software configurable)

±3 ppm

N-type female 50 Ω
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System performance specifications 
Capacity ETSI C2

Channel size

25 kHz C3 Gross 72 kbit/s 96 kbit/s 112 kbit/s

E1 1 timeslots 1 timeslots 1 timeslots

Wayside 8 kbit/s 32 kbit/s 48 kbit/s

50 kHz C3 Gross 80 kbit/s 168 kbit/s 208 kbit/s 256 kbit/s

E1 1 timeslots 2 timeslots 3 timeslots 4 timeslots

Wayside 16 kbit/s 40 kbit/s 16 kbit/s 0 kbit/s

75 kHz C4 Gross 128 kbit/s 264 kbit/s 312 kbit/s 400 kbit/s

E1 2 timeslots 4 timeslots 4 timeslots 6 timeslots

Wayside 0 kbit/s 8 kbit/s 56 kbit/s 16 kbit/s

150 kHz C4 Gross 264 kbit/s 536 kbit/s 672 kbit/s 808 kbit/s

E1 4 timeslots 8 timeslots 10 timeslots 12 timeslots

Wayside 8 kbit/s 24 kbit/s 32 kbit/s 40 kbit/s

200 kHz C5 Gross 336 kbit/s 680 kbit/s 840 kbit/s

E1 5 timeslots 10 timeslots 13 timeslots

Wayside 16 kbit/s 40 kbit/s 8 kbit/s

250 kHz Gross 408 kbit/s 824 kbit/s 1032 kbit/s 1240 kbit/s

E1 6 timeslots 12 timeslots 16 timeslots 19 timeslots

Wayside 24 kbit/s 56 kbit/s 8 kbit/s 24 kbit/s

500 kHz Gross 792 kbit/s 1592 kbit/s 1992 kbit/s 2392 kbit/s

E1 12 timeslots 24 timeslots 31 timeslots 1 E1

Wayside 24 kbit/s 56 kbit/s 8 kbit/s 304 kbit/s

1 MHz Gross 1624 kbit/s 3256 kbit/s 4072 kbit/s 4888 kbit/s

E1 25 timeslots 1 E1 1 E1 2 E1

Wayside 24 kbit/s 1168 kbit/s 1984 kbit/s 712 kbit/s

1.75 MHz Gross 2872 kbit/s 5752 kbit/s 7192 kbit/s 8632 kbit/s

E1 1 E1 2 E1 3 E1 4 E1

Wayside 784 kbit/s 1576 kbit/s 928 kbit/s 280 kbit/s

3.5 MHz Gross 5720 kbit/s 11448 kbit/s 14312 kbit/s 17176 kbit/s

E1 2 E1 5 E1 6 E1 8 E1

Wayside 1544 kbit/s 1008 kbit/s 1784 kbit/s 472 kbit/s

7 MHz C6 Gross 11832 kbit/s 23672 kbit/s 29592 kbit/s 35512 kbit/s

E1 5 E1 11 E1 14 E1 17 E1

Wayside 1392 kbit/s 704 kbit/s 360 kbit/s 16 kbit/s

14 MHz C6 Gross 23992 kbit/s 47992 kbit/s 59992 kbit/s 65464 kbit/s

E1 11 E1 22 E1 28 E1 28 E1

Wayside 1024 kbit/s 2056 kbit/s 1528 kbit/s 7000 kbit/s

Note C2 The capacities specif ied are for Unframed E1 and so require 2088 kbit/s to transport via the radio.
The management ethernet capacity must be subtracted from the gross capacity (default 64 kbit/s).

Note C3 Available only in the 300 and 400 MHz bands.
Note C4 Available only in the 300, 400 and 1400 MHz bands.
Note C5 Available only in the 700, 800 and 900 MHz bands.
Note C6 Available only in the 2000 and 2500 MHz bands.

64 QAMQPSK 16 QAM 32 QAM
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Capacity FCC D1

Channel size

25 kHz D2 Gross 56 kbit/s 72 kbit/s 88 kbit/s

T1 0 timeslots 1 timeslots 1 timeslots

Wayside 56 kbit/s 8 kbit/s 24 kbit/s

100 kHz D3 Gross 136 kbit/s 280 kbit/s 352 kbit/s 424 kbit/s

T1 2 timeslots 4 timeslots 5 timeslots 6 timeslots

Wayside 8 kbit/s 24 kbit/s 32 kbit/s 40 kbit/s

200 kHz D4 Gross 312 kbit/s 632 kbit/s 792 kbit/s

T1 4 timeslots 9 timeslots 12 timeslots

Wayside 56 kbit/s 56 kbit/s 24 kbit/s

250 kHz D5 Gross 408 kbit/s 824 kbit/s 1032 kbit/s 1240 kbit/s

T1 6 timeslots 12 timeslots 16 timeslots 19 timeslots

Wayside 24 kbit/s 56 kbit/s 8 kbit/s 24 kbit/s

500 kHz D5 Gross 792 kbit/s 1592 kbit/s 1992 kbit/s 2392 kbit/s

T1 12 timeslots 1 T1 1 T1 1 T1

Wayside 24 kbit/s 8 kbit/s 408 kbit/s 808 kbit/s

Note D1 The capacities specif ied are for Unframed T1 and so require 1584 kbit/s to transport via the radio.
The management ethernet capacity must be subtracted from the gross capacity (default 64 kbit/s).

Note D2 Available only in the 400 MHz band (available in 1Q2007)
Note D3 Available only in the 900 MHz band (available in 1Q2007).
Note D4 Available only in the 900 MHz band
Note D5 Available only in the 2000 and 2500 MHz bands (available in 1Q2007)

64 QAM

(20 kHz occ bw) 
(part 90)

QPSK 16 QAM 32 QAM

(part 27)

(part 27)

(part 101)

(part 101)
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Receiver sensitivity R1

Channel size
25 kHz -105 dBm -102 dBm -99 dBm

50 kHz -109 dBm -103 dBm -100 dBm -97 dBm

75 kHz -107 dBm -101 dBm -98 dBm -95 dBm

100 kHz -106 dBm -100 dBm -97 dBm -94 dBm

150 kHz -104 dBm -98 dBm -95 dBm -92 dBm

200 kHz -102 dBm -96 dBm -93 dBm

250 kHz -101 dBm -95 dBm -92 dBm -89 dBm

500 kHz -99 dBm -93 dBm -90 dBm -87 dBm

1 MHz -96 dBm -90 dBm -87 dBm -84 dBm

1.75 MHz -94 dBm -88 dBm -85 dBm -82 dBm

3.5 MHz -90 dBm -84 dBm -81 dBm -78 dBm

7 MHz -87 dBm -81 dBm -78 dBm -75 dBm

14 MHz -84 dBm -78 dBm -75 dBm -72 dBm

Note R1 Typical performance specif ied at the antenna port for 10-6 BER.
The receiver is typically 1 dB more sensitive for a BER of 10-3.

QPSK 16 QAM 32 QAM 64 QAM

 
 

System Gain S1,S2

Channel size
25 kHz 136 dB 132 dB 128 dB

50 kHz 144 dB 134 dB 130 dB 126 dB

75 kHz 142 dB 132 dB 128 dB 124 dB

100 kHz 141 dB 131 dB 127 dB 123 dB

150 kHz 139 dB 129 dB 125 dB 121 dB

200 kHz 137 dB 127 dB 123 dB

250 kHz 136 dB 126 dB 122 dB 118 dB

500 kHz 134 dB 124 dB 120 dB 116 dB

1 MHz 131 dB 121 dB 117 dB 113 dB

1.75 MHz 129 dB 119 dB 115 dB 111 dB

3.5 MHz 125 dB 115 dB 111 dB 107 dB

7 MHz 122 dB 112 dB 108 dB 104 dB

14 MHz 119 dB 109 dB 105 dB 101 dB

Note S1 Typical performance specif ied at the antenna port for 10-6 BER.
The system gain is typically 1 dB greater for a BER of  10-3.

Note S2 Figures reduce by 4 dB for 32 QAM and 8 dB for 64 QAM.
Figures increase by 10 dB for QPSK (9 dB for the 2000 and 2500 MHz bands).

QPSK 16 QAM 32 QAM 64 QAM
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Note: The default Modem Interleaver Mode setting is on for channel sizes of 250 kHz and greater and 
off for channel sizes of 200 kHz and less (see “Modem Interleaver Mode” on page 63). 

Typical end-to-end link delay (ETSI) - interleaver off L1

Channel size
25 kHz 48.3 ms 38.7 ms 34.2 ms

50 kHz 41.8 ms 22.8 ms 19.2 ms 16.4 ms

75 kHz 34.8 ms 18.5 ms 16.2 ms 13.5 ms

100 kHz 26.2 ms 14.6 ms 12.0 ms 10.5 ms

150 kHz 17.4 ms 9.8 ms 8.2 ms 7.4 ms

200 kHz 13.6 ms 7.9 ms 6.9 ms

250 kHz 10.8 ms 6.5 ms 5.5 ms 4.9 ms

500 kHz 5.8 ms 3.9 ms 3.4 ms 3.2 ms

1 MHz 3.67 ms 2.61 ms 2.59 ms 2.55 ms

1.75 MHz 2.93 ms 2.33 ms 2.12 ms 2.03 ms

3.5 MHz 2.40 ms 2.11 ms 2.05 ms 2.08 ms

7 MHz 2.20 ms 1.89 ms 1.77 ms 1.71 ms

14 MHz 2.08 ms 1.83 ms 1.75 ms 1.64 ms

Typical end-to-end link delay (ETSI) - interleaver on L1

Channel size
25 kHz 163.0 ms 126.9 ms 110.8 ms

50 kHz 146.7 ms 75.4 ms 62.1 ms 51.5 ms

75 kHz 103.0 ms 52.8 ms 45.5 ms 36.4 ms

100 kHz 78.8 ms 41.1 ms 33.2 ms 28.2 ms

150 kHz 50.9 ms 26.6 ms 21.9 ms 18.9 ms

200 kHz 40.5 ms 21.5 ms 18.0 ms

250 kHz 33.1 ms 17.7 ms 14.5 ms 12.4 ms

500 kHz 17.4 ms 9.5 ms 8.2 ms 7.1 ms

1 MHz 9.31 ms 5.50 ms 4.79 ms 4.44 ms

1.75 MHz 6.04 ms 3.87 ms 3.47 ms 3.16 ms

3.5 MHz 3.79 ms 2.84 ms 2.44 ms 2.54 ms

7 MHz 2.67 ms 2.23 ms 1.92 ms 1.86 ms

14 MHz 2.11 ms 2.01 ms 1.86 ms 1.89 ms

Note L1 The end to end link delays are measured from E1 interface to E1 interface 
The delay f igures are typical and can vary w hen the system re-synchronizes

QPSK 16 QAM 32 QAM 64 QAM

QPSK 16 QAM 32 QAM 64 QAM
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Transmitter ETSI

Modulation Type Frequency bands Power output range
(in 1 dB steps)

QPSK 300, 400, 600, 700, 800, 900 & 1400  MHz bands +21 to +35 dBm

QPSK 2000, 2500 MHz bands +20 to +34 dBm

16 QAM all bands +17 to +31 dBm

32 QAM all bands +16 to +30 dBm

64 QAM all bands +15 to +29 dBm

Transmitter FCC

Modulation Type Frequency bands Power output range
(in 1 dB steps)

QPSK 400 MHz band +21 to +35 dBm

QPSK 900 MHz band +15 to +29 dBm

16 QAM 400 MHz band +17 to +31 dBm

16 QAM 900 MHz band +15 to +29 dBm

32 QAM 400 MHz band +16 to +30 dBm

32 QAM 900 MHz band +15 to +29 dBm

64 QAM 400 MHz band +15 to +29 dBm
 

Receiver
-20 dBm

58 to 87 dB (at 10-6 BER)
depending on modulation type and channel s ize 

C/I ratio =  CdB - IdB

Co-channel better than 16 dB at QPSK

better than 20 dB at 16 QAM

better than 23 dB at 32 QAM

better than 27 dB at 64 QAM

1st adjacent channel better than -5 dB

2nd adjacent channel better than -30 dB

Note B1 Typical performance specif ied at the antenna port for 10-6 BER.
The dynamic range is typically 2 dB greater for a BER of 10-3.

Maximum input level

Dynamic range B1

C/I ratio
(carrier to interference ratio)
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Duplexer ETSI F1

Passband Frequency Bands TX / RX Split
500 kHz 300, 400 MHz bands > 5 MHz

2 MHz 300, 400 MHz bands > 9.45 MHz

3.5 MHz 300, 400 MHz bands > 20 MHz

7 MHz 700 MHz band > 30 MHz

600 MHz band > 45 MHz

800, 900 MHz bands > 40 MHz

1400 MHz band > 48 MHz

14 MHz 2000 MHz band > 91 MHz

2500 MHz band > 74 MHz

Duplexer FCC / IC F1

Passband Frequency Bands TX / RX Split
500 kHz 400 MHz band > 3 MHz

1 MHz 900 MHz band > 9 MHz

Note F1 Bandpass duplexer
Contact 4RF for other duplexer options  
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Interface specifications 
 

Ethernet interface 
General Interface RJ-45 * 4 (Integrated 4-port switch) 

 Cabling CAT-5 UTP, supports auto MDIX (Standard Ethernet) 

 Maximum line length 100 metres on cat-5 or better 

 Bandwidth allocation n x 8 kbit/s up to max available.  
n x 64 kbit/s is recommended for higher bandwidth terminals 
� 500 kHz, 32 QAM.  
Maximum is 16384 kbit/s (or limited by radio bandwidth). 

 Maximum packet size ‘Standard’ Ethernet packets: max 1518 octets 
Tagged and double-tagged packets: max 1526 octets 

 Data buffer size Up to 256 frames 

 Address table size 2048 IP addresses 

 WAN protocol HDLC 

 Ethernet mode 10Base-T or 100Base-TX  
Full duplex or half duplex  
(Auto-negotiating and auto-sensing) 

 VLAN tagging IEEE 802.1Q VLAN tagging 

 QoS IEEE 802.1p 
Ipv4 TOS DiffServ 
Ipv6 traffic class 

 Spanning Tree Forwards 802.1D Spanning Tree Protocol packets up to 1526 
bytes in length. 

Diagnostics Hardware Green LED (solid): Link OK 
Green LED (flashing): Data traffic 

 

QJET Quad E1 / T1 interface 
General Standard G.703 and G.704 

 Interface RJ-45 

 Line termination impedance E1  120 Ω balanced 
T1  100 Ω balanced 

 Maximum line length E1 typically up to 1.7 km (43 dB of loss at 1024 kHz in 
standard 0.4 mm2 cable). 
T1 typically up to 1.7 km (36 dB of loss at 772 kHz in standard 
0.4 mm2 cable). 

 Bandwidth allocation Framed E1s require a link bandwidth of 2048 kbit/s. 
Unframed E1s require a link bandwidth of 2088 kbit/s. 
Framed T1s require a link bandwidth of 1544 kbit/s. 
Unframed T1s require a link bandwidth of 1584 kbit/s. 

 Line code E1  HDB3 or AMI 
T1  B8ZS or AMI 

 Tx Waveform Shaper 
(T1 only) 

0 ~ 133 ft 
133 ~ 266 ft 
266 ~ 399 ft 
399 ~ 533 ft 
533 ~ 655 ft 

 Stability ±50 ppm 

 Jitter performance G.823 (sections 2 & 3) 

Diagnostics Hardware Green LED: Link OK  
Yellow LED: Loss of signal 
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Q4EM Quad 4 wire E&M interface 
General Audio 64 kbit/s (PCM A-Law as per ITU G.711)  

32, 24 & 16 kbit/s (ADPCM as per ITU G.726 and ANSI 
TI.303) 

 E&M signalling 8 kbit/s per port 

 Maximum line length 400 metres 

Analogue Transmission performance 
characteristics 

ITU G.712 E4 for an operating level range of -14 dBr to +4 
dBr 

 Input level range -14.0 dBr to +4.0 dBr in 0.5 dB steps 

 Output level range -14.0 dBr to +4.0 dBr in 0.5 dB steps 

 Default output level 0 dBr 

 Default input level 0 dBr 

 Maximum level +3.14 dBm0 

 Port impedance 600 Ω 

 Return loss better than 25 dB over the frequency range 200 - 3600 Hz  

 Transformer isolation 3.88 kV 

 End to end gain 
Frequency response 

0 dB ± 0.1 dB (300-3000 Hz) 
0 dB ± 0.5 dB (250-3400 Hz) 

 Audio line protection Secondary protection 

 Signal to total distortion > 30 dB (0 dBm0 to -30 dBm0) 
> 22 dB (-45 dBm0) 

Signalling E&M Mode independent (external power supply / ground reference 
required) 

 Pulse distortion 4:1 multiplexed < 2.250 ms 
Non-multiplexed ≤ 250 µs 

 M loop current 5.0 to 6.5 mA (constant current) 

 M detection voltage 9 VDC 

 M maximum voltage 60 VDC 

 E circuit impedance 45 Ω closed 
> 100 kΩ open 

 Maximum E circuit current 100 mA 

 E maximum voltage 60 V 

 E&M circuit protection E: Current limited to 120 mA, overvoltage to 350 V 
M: Current limited to 6.5 mA, overvoltage to 100 V 

Diagnostics Hardware Green LED: M circuit active 
Yellow LED: E circuit active 
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DFXO Dual foreign exchange office interface 
General Audio 64 kbit/s (PCM as per ITU G.711)  

32, 24 and 16 kbit/s (ADPCM as per ITU G.726 and ANSI 
TI.303) 

 Signalling allocation 8 or 32 kbit/s allocated for CAS 

 Companding A-Law or µ-Law 

 Maximum line length 600 metres (2000 feet) on 0.4 mm / 26 AWG copper pair 

 Calling line ID (CLI) Support provided for ETSI: EN 300 659-1 & 2 and BT: SIN 
227 and 242 

 Fax Conforms to G3 standard for 64 kbit/s PCM and 32 kbit/s 
ADPCM compression 

Analogue Transmission performance 
characteristics 

ITU G.712 E2 for an operating level range of -6 dBr to +1 dBr 

 Input level range -10 dBr to +1.0 dBr in 0.5 dB steps 

 Output level range -10 dBr to +1.0 dBr in 0.5 dB steps 

 Default Input level -4.0 dBr 

 Default Output level -1.0 dBr 

 Maximum level +3.14 dBm0 

 Line impedance / Hybrid 
balance impedance options 

600 Ω 
900 Ω 
600 Ω + 2.16 µF 
900 Ω + 2.16 µF 
270 Ω + 750 Ω || 150 nF (TBR-21) 
220 Ω + 820 Ω || 120 nF (TN12) 
370 Ω + 620 Ω || 310 nF (BT3) 
320 Ω + 1050 Ω || 210 nF (BT Network) 
200 Ω + 680 Ω || 100 nF (China) 

 Return Loss better than 20 dB over the frequency range 200 - 3600 Hz  

 Trans hybrid loss better than 30 dB between 300 - 3400 Hz (with matched 
external line and hybrid balance impedance) 

 Common mode rejection ratio better than 40 dB over the frequency range 50 - 3600 Hz 

 Echo Canceller provides up to 64 ms of echo cancellation 
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Signalling Pulse dialing Transparent decadic signalling at 7 - 14 PPS with break 

period limits of 60 - 73 % 

 Pulse distortion 4:1 multiplexed < 2.250 ms 
Non-multiplexed ≤ 250 µs 

 Reversals Line polarity reversal detection 

 Metering level sensitivity 12 kHz / 16 kHz billing tone detection with a selectable level 
sensitivity of -17dBm to -40 dBm in 1dB steps into 200 Ω 
(60 mV rms to 5 mV rms into 200 Ω). 

 Metering level maximum The maximum level of metering signal the DFXO can tolerate 
without voice band interference is 0.8 Vrms into 200 Ω. 

 Loop resistance on-hook >1 MΩ 

 Ringing detection threshold Options of 16 Vrms, 26 Vrms or 49 Vrms 

 Ringing detection frequency 15 to 50 Hz sine wave 

 Ringing input impedance Option of >10 MΩ or 30kΩ 

 Ringing DC offset range 
tolerance 

0 to -75VDC 

 Ringing input voltage 
maximum 

up to 100 Vrms 

Physical Physical interface Dual RJ-45 per port (1 line port, 1 monitor port) 

Diagnostics Green LED On: Normal operation 
Solid: Off-hook 
Flashing: Ringing 

 Yellow LED On: Alarm 
Flashing: Loopback 
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DFXS Dual foreign exchange subscriber interface 
General Audio 64 kbit/s (PCM as per ITU G.711)  

32, 24 and 16 kbit/s (ADPCM as per ITU G.726 and ANSI 
TI.303) 

 Signalling Allocation 8-32 kbit/s allocated for CAS 

 Compression coding A-Law or µ-Law 

 Maximum line length 600 metres (2000 feet) on 0.4 mm / 26 AWG copper pair 

 Calling line ID (CLI) Support provided for ETSI: EN 300 659-1 & 2 and BT: SIN 
227 and 242 

 Fax Conforms to G3 standard for 64 kbit/s PCM and 32 kbit/s 
ADPCM compression 

Analogue Transmission performance 
characteristics 

ITU G.712 E2 for an operating level range of -6 dBr to +2.5 
dBr 

 Input level range -9.0 dBr to +3.0 dBr in 0.5 dB steps 

 Output level range -9.5 dBr to +2.5 dBr in 0.5 dB steps 

 Default Input level +1.0 dBr 

 Default Output level -6.0 dBr 

 Maximum level +3.14 dBm0 

 Line impedance / Hybrid 
balance impedance options 

600 Ω 
900 Ω 
600 Ω + 2.16 µF 
900 Ω + 2.16 µF 
220 Ω + (820 Ω || 120 nF) (TN12) 
270 Ω + (750 Ω || 150 nF) (TBR21) 
370 Ω + (620 Ω || 310 nF) (BT3) 

 Return Loss better than 20 dB over the frequency range 200 - 3600 Hz 

 Trans hybrid loss better than 30 dB between 300 - 3400 Hz (with matched 
external line and hybrid balance impedance) 

 Common mode rejection ratio better than 40 dB over the frequency range 50 - 3600 Hz 
 



Specifications  |  249 
 

 

 
Signalling Feed voltage output -48 V (160 + 160 Ω voltage source current limited) 

 Loop current limit 35 mA 

 Seize signal Loop start only (no ground start) 

 Loop detect threshold 10 - 12 mA (step function between on hook and off hook) 

 Non loop current 4 - 6 mA (step function between on hook and off hook) 

 Pulse dialing Transparent decadic signalling at 7 - 14 PPS with break 
period limits of 60 - 73 % (with loop current > 23 mA) 

 Pulse distortion 4:1 multiplexed < 2.250 ms 
Non-multiplexed ≤ 250 µs 

 Reversals output Line polarity reversal output (optional) 

 Metering output voltage 12 kHz / 16 kHz billing tone generation with four selectable 
output voltages of 100 mV, 200 mV, 300 mV and 400 mV rms 
into 200 Ω sourced via the Line Impedance setting but limited 
to a maximum open circuit voltage of 1 Vrms.  

 Ringer waveform Sinusoidal with a maximum total distortion of 10% (into 3 REN 
load) 

 Ringer voltage (open circuit) Five selectable ringer output voltages sourced via an internal 
ringing resistance of 178 Ω per port. 
The ringing output is a composite balanced AC ringing voltage 
with a differential DC offset voltage. 

60 Vrms + 0 VDC 
55 Vrms + 10 VDC 
50 Vrms + 18 VDC 
45 Vrms + 22 VDC 
40 Vrms + 24 VDC 

 Ringer frequency output Options of 17, 25 or 50 Hz ±5% 

 Ringer power output 60 Vrms source into a load of 2 REN 
45 Vrms source into a load of 3 REN 
(1 REN ≈ 6930 Ω in series with 8 μF) 

 Ring Trip Ring Trip will ocurr in < 150 ms following DC loop of > 15 mA 

 Ring Trip Immunity Ring Trip will not ocurr if the DFXS outputs ringing into a load 
of 500 Ω in series with 4.4μF or less. 

Physical Physical interface Dual RJ-45 per port (1 line port, 1 monitor port) 

 Line protection Secondary protection (4RF recommends the use of external 
primary protection in lightning prone areas) 

Diagnostics Green Led Green LED 
On: Normal operation 
Solid: Off-hook 
Flashing: Ringing 

 Yellow LED On: Alarm 
Flashing: Loopback 
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QV24 Quad V.24 asynchronous data interface 
General Interface ITU-T V.24/EIA/TIA RS-232E 

 Bandwidth allocation 8-120 kbit/s in 8 kbit/s steps (dependent on rate selected) 

 Control line allocation 8 kbit/s 

 Maximum line length 10 metres 

 Data clamp Mark hold when out of sync. 

 Control line clamp Off when loss of sync. 

 Clock Internally generated from 2.048 MHz system clock 
(synchronized at both ends) 

Async 
parameters 

Transparent mode Operation is completely transparent but limited to 0-600 bit/s 

 Standard mode data bits 7,8 

 Standard mode parity Transparent  (enable / disable) 

 Standard mode stop bits 1,2 

 Data rates (bit/s) 300, 600, 1200, 2400, 4800, 7200, 9600, 12800, 14400, 
19200, 23040, 28800, 38400, 57600 and 115200 

Control 
signals 

End-to-end CTS-RTS, DSR-DTR 

Diagnostics Green LED RD data traffic 

 Yellow LED TD data traffic 
 

HSS Single high speed synchronous data interface 
General Interfaces ITU-T V.24 EIA/TIA RS-232E 

ITU-T V.35 
ITU-T V.36 EIA/TIA RS-449 
ITU-T X.21 
EIA/TIA 530 

 Bandwidth allocation 8-2048 kbit/s in 8 kbit/s steps (dependent on rate selected) 
8 kbit/s for control lines 

 Maximum line length 3 metres 

 Clock Internally generated from 2.048 MHz system clock 
(synchronized at both ends) on DCE to DCE mode. 
Clock provided by external DCE when in DTE mode. 
Remote DCE outputs clock-timed by incoming clock at DTE. 

Diagnostics Top Green LED On: Normal operation 
Flashing: Loopback 

 Lower Green LED On: Normal operation 
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External alarm interfaces 
Alarm inputs Detector type Isolated current detectors 

 Detection current 5.0 to 6.5 mA (constant current) 

 Detection voltage 9 to 60 VDC or AC rms 

Alarm outputs Contact type Isolated semiconductor relay type contacts 

 Maximum current 100 mA 

 Maximum voltage 0 to 60 VDC or AC rms 

 Ouput impedance 45 Ω closed 
> 100 kΩ open 

Overall Latency The latency for an alarm presented on an external alarm input 
to the alarm being output on an external alarm output is < 2 
seconds 

 

Auxiliary interfaces 
Management Configuration and 

management 
Embedded web server and / or SNMP accessed via Ethernet 
interface or across link 

Test points RSSI Front panel test point for measuring the RSSI voltage 
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Power specifications 
 

AC Power supply 
Nominal 
voltage 

Input voltage 
range 

Power consumption Max VA Frequency 

115 VAC 103 - 127 Vrms 63 - 180 W 400 VA 47 - 63 Hz 

230 VAC 207 - 254 Vrms 63 - 180 W 400 VA 47 - 63 Hz 
 

DC Power supply 
Nominal 
voltage 

Input voltage 
range 

Power consumption Maximum input current 

±12 VDC 10.5 to 18 VDC 63 - 180 W 18 A 

±24 VDC 20.5 to 30 VDC 63 - 180 W 8 A 

±48 VDC 40 to 60 VDC 63 - 180 W 4 A 
 

Power consumption 
Power Consumption (min – max) 63 - 180 W Input power (dependent on interface cards fitted and 

modulation type / output power level) 

Terminal only: 

 QPSK + 19 dBm 65 W 

 QPSK + 29 dBm 68 W 

 QPSK + 32 dBm 72 W 

 QPSK + 35 dBm 75 W 

 64 QAM + 15 dBm 63 W 

 64 QAM + 29 dBm 71 W 

Interface cards: 

 QJET four port E1 card 1.9 W (all states) 

 Q4EM four port 4W E&M card 0.75 W (all states) 

 QV24 four port V.24 card 0.75 - 1 W (all states) 

 DFXO two port 2W FXO card 0.75 W (all states) 

 DFXS two port 2W FXS card One DFXS card installed with both ports idle (on hook): 3.8 W 
Plus: 
1.3 W / line off-hook (200 ohm copper loop plus 450 ohm 
telephone)   
2.6 W / line ringing (60 Vrms 25Hz source via 50 ohm copper loop 
into a 1 REN load)  
4.1 W / line ringing (45 Vrms 25Hz source via 50 ohm copper loop 
into a 3 REN load) 

 HSS single port high speed data 1 W (all states) 

MHSB: 

Tributary and RF switch 16 W not switched 

 28 W switched 
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MHSB specifications 
 

MHSB protection 
RF switch TX relay loss ≈ 1.5 dB 

 Splitter loss ≈ 3.5 dB 

 Switching time < 25 ms seconds from detection of alarm condition 

 RF path restore time < 10 seconds 

Tributary switch Ports 8 
 
 

General specifications 
Environmental 
 

Operating range -10 to +50˚ C 

Storage range -20 to +70˚ C 

Humidity Maximum 95% non-condensing 

Altitude Up to 5000 metres 
 

Mechanical 
 

19-inch rack mount 2 U high (internal duplexer)  
3 U high (external duplexer) 

Width 434 mm (without mounting brackets attached) 
483 mm (with mounting brackets attached) 

Height 88 mm 

Depth 372 mm  

Colour Pure black 

Weight ≈ 8 kg (per terminal) 
 

ETSI performance 
 

Radio EN 301 751, EN 300 630 
EN 302 217 Parts 1, 2.1, and 2.2 

EMI/EMC EN 301 489 Parts 1 & 4 

Safety EN 60950 

Environmental ETS 300 019 Class 3.2 
 





Product end of life  |  255 
 

 

19. Product end of life 
End-of-life recycling programme (WEEE) 
The WEEE Directive concerns the recovery, reuse, and recycling of electronic and electrical 
equipment. Under the Directive, used equipment must be marked, collected separately, and disposed 
of properly. 

4RF Communications has implemented an end-of-life recycling programme to manage the reuse, 
recycling, and recovery of waste in an environmentally safe manner using processes that comply with 
the WEEE Directive (EU Waste Electrical and Electronic Equipment 2002/96/EC). 

 

The WEEE symbol explained 

 
This symbol appears on Electrical and Electronic Equipment (EEE) as part of the WEEE (Waste EEE) 
directive. It means that the EEE may contain hazardous substances and must not be thrown away with 
municipal or other waste. 

 

WEEE must be collected separately 
You must not dispose of electrical and electronic waste with municipal and other waste. You must 
separate it from other waste and recycling so that it can be easily collected by the proper regional 
WEEE collection system in your area. 

 

Return and collection programmes in your area 
Contact your local or regional authority for information about the return and collection programmes 
available in your area. 

 

Your role in the recovery of WEEE 
By separately collecting and properly disposing of WEEE, you are helping to reduce the amount of 
WEEE that enters the waste stream. 

One of the aims of the WEEE directive is to divert EEE away from landfill and encourage recycling. 
Recycling EEE means that valuable resources such as metals and other materials (which require 
energy to source and manufacture) are not wasted. Also, the pollution associated with accessing new 
materials and manufacturing new products is reduced. 

 

EEE waste impacts the environment and health 
Electrical and electronic equipment (EEE) contains hazardous substances which have potential effects 
on the environment and human health. If you want environmental information on the Aprisa XE 
terminal, contact us (on page 15).  





Abbreviations  |  257 
 

 

20. Abbreviations 
ADC Analogue to Digital Converter 

ADPCM Adaptive Differential Pulse Code 
Modulation 

ADSL Asymmetrical Digital Subscriber Line 

AGC Automatic Gain Control 

AMP Amplifier 

BER Bit Error Rate 

CAS Channel Associated Signalling 

CPE Customer Premises Equipment 

CLI Calling Line Identification 

DAC Digital to Analogue Converter 

dB Decibels 

dBc Decibels relative to carrier power 

dBm Decibels relative to 1 mW 

dBr Decibels relative to the tramsmission 
reference point 

DCE Data Communications Equipment 

DS0 Digital Signal 0 - 64 kbit/s Timeslot 

DTE Data Terminal Equipment 

DTI Digital Trunk Interface 

E&M Ear and Mouth 

EMC Electro-Magnetic Compatibility 

EMI Electro-Magnetic Interference 

ESD Electro-Static Discharge 

ETSI European Telecommunications Standards 
Institute 

FAS Frame Alignment Signal (E1 frame) 
FEC Forward Error Correction 

FFE Feed Forward Equalizer 

F/W Firmware 

FXO Foreign Exchange Office 

FXS Foreign Exchange Subscriber 

GSM Global System for Mobile communications 

HSC Hardware Software Compatibility 

HSS High-Speed Synchronous Serial 

H/W Hardware 

IC Integrated Circuit 

IF Intermediate Frequency 

IP Internet Protocol 

I/O Input/Output 

ISP Internet Service Provider 

kbit/s Kilobits per second 

kHz Kilohertz 

LAN Local Area Network 

LED Light Emitting Diode 

LOS Loss of Signal 

mA Milliamps 

MAC Media Access Control 

Mbit/s Megabits per second 

MHSB Monitored Hot Standby 

MHz Megahertz 

MIB Management Information Base 

MTBF Mean Time Between Failures 

MTTR Mean Time To Repair 

ms milliseconds 

NFAS Not Frame Alignment Signal (E1 
frame) 

NMS Network Management System 

OSI Open Systems Interconnection 

PABX Private Automatic Branch Exchange 

PBX Private Branch Exchange 

PC Personal Computer 

PCM Pulse Code Modulation 

PCA Printed Circuit Assembly 

PLL Phase Locked Loop 

POP Point of Presence 

POTS Plain Old Telephone Service 

ppm Parts Per Million 

PSTN Public Switched Telephone Network 

PMR Public Mobile Radio 

QAM Quadrature Amplitude Modulation 

QPSK Quadrature Phase Shift Keying 

RAI Remote Alarm Indicator 

RF Radio Frequency 

RoHS Restriction of Hazardous Substances 

RSSI Received Signal Strength Indication 

RX Receiver 

SNMP Simple Network Management Protocol 

SNR Signal to Noise Ratio 

SWR Standing Wave Ratio 

TCP/IP Transmission Control Protocol/Internet 
Protocol 

TCXO Temperature Compensated Crystal 
Oscillator 

TETRA Terrestrial Trunk Radio 

TFTP Trivial File Transfer Protocol 

TMR Trunk Mobile Radio 

TX Transmitter 

UTP Unshielded Twisted Pair 

VCO Voltage Controlled Oscillator 

VDC Volts DC 

VoIP Voice over Internet Protocol 

WEEE Waste Electrical and Electronic 
Equipment 
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21. Acknowledgments and licensing 
The Aprisa XE product software runs the GNU Linux Operating System and incorporates several other 
packages in accordance with the free software philosophy. 

The following list identifies the licensed software used: 

BusyBox 
Description: Tiny versions of common UNIX utilities 

Reference: http://busybox.net/ 

License Type: GNU General Public License (GPL) 

DropBear SSH Server 
Description: Small and secure SSH Server 

Reference: http://matt.ucc.asn.au/dropbear/ 

License Type: MIT Style License 

GoAhead WebServer 2.1 
Description: Embedded Web Server 

Reference: http://webserver.goahead.com/ 

License Type: Private License 

Linux Kernel 
Description: Linux Kernel version 2.4.26 

Reference:  http://www.kernel.org/ 

License Type: GNU General Public License (GPL) 

Net-SNMP 
Description: Various tools relating to SNMP 

Reference: http://www.net-snmp.org/ 

License Type: CMU/UCD and BSD License 

uClibc 
Description: C library for embedded Linux systems 

Reference: http://uclibc.org/ 

License Type: GNU Lesser General Public License (LGPL) 

U-Boot 
Description: Bootloader 

Reference: http://u-boot.sourceforge.net/ 

License Type: GNU General Public License (GPL) 
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Software licensed under the GPL 
Some of the above packages licensed under the GPL have been modified by 4RF Communications 
Limited. The copyright holders of these modified packages (including 4RF Communications Limited) 
agree to them being distributed under the terms of the General Public License. 

Copies of the GNU General Public License (GPL) and Lesser General Public License (LGPL) can be 
obtained from the Free Software Foundation Inc, 59 Temple Place - Suite 330, Boston, MA, 02111-
1307, USA.  Plain text copies of these licenses can also be found at: 

http://www.gnu.org/licenses/gpl.txt 

http://www.gnu.org/licenses/lgpl.txt 

If you would like a copy of the GPL source code used in this product on a CD, please send US$50.00 
(to cover the preparation of the CD and transport costs) to 4RF Communications Limited, PO Box 13-
506, Wellington, New Zealand. 

Software licensed under other licences 
The following copyright notices are included for packages not covered by the GPL: 

Dropbear SSH Server (MIT License) 
Dropbear—a SSH2 server 

Copyright © 2002, 2003 Matt Johnston 

All rights reserved 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to 
the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER 
LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, 
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN 
THE SOFTWARE. 
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Net-SNMP 
Part 1: CMU/UCD (BSD like) 

Copyright © 2001-2003, Networks Associates Technology, Inc 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may 
be used to endorse or promote products derived from this software without specific prior written 
permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS'' 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

Part 2: Networks Associates Technology, Inc. (BSD) 

Copyright © 2001-2003, Networks Associates Technology, Inc 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may 
be used to endorse or promote products derived from this software without specific prior written 
permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS'' 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
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Part 3: Cambridge Broadband Ltd (BSD) 

Portions of this code are copyright © 2001-2003, Cambridge Broadband Ltd. 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived 
from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS'' AND ANY EXPRESS OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO 
EVENT SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, 
OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE 
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Part 4: Sun Microsystems, Inc. (BSD) 

Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, 

California  95054, U.S.A. All rights reserved. 

Use is subject to license terms below. 

This distribution may include materials developed by third parties. 

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS'' 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 
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Part 5: Sparta, Inc. (BSD) 

Copyright © 2003-2004, Sparta, Inc 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may 
be used to endorse or promote products derived from this software without specific prior written 
permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS'' 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

GoAhead WebServer (Private License) 
GoAhead WebServer 

Copyright (c) 2000 GoAhead Software, Inc. All Rights Reserved 
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23. Index 
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access rights................................................... 57 
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AIS................................................................ 206 
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port settings for ....................................... 109 

humidity.......................................................... 23 

I 
image files .................................................... 184 

updating table of ..................................... 188 
in-service commissioning............................. 163 
installation ................................................ 29, 31 
interface cabling ............................................. 32 
interface cards 
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